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damage to the product or loss of important 
data. Do not proceed beyond a CAUTION 
notice until the indicated conditions are 
fully understood and met.

,

mailto:service.automation@agilent.com
mailto:orders.automation@agilent.com
http://www.chem.agilent.com/en-US/Contact-US/Pages/ContactUs.aspx
mailto:documentation.automation@agilent.com
http://www.agilent.com/lifesciences/automation


iiiVWorks Automation Control Setup Guide

Contents

Preface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v
About this guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  vi
Accessing Automation Solutions user guides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  viii

1.   Installing and setting up the VWorks software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
Installing and uninstalling the software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
Logging in and setting up the software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
Reporting problems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

2.   Defining labware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
About defining labware with the Labware Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Labware Editor overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Workflow for defining labware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13
Opening the Labware Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
Adding a labware entry  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
Setting general properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
Setting microplate properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22
Setting tip and well properties for pipetting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
Creating and assigning labware classes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Using labware classes example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
Adding a labware image. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36
Setting Centrifuge Loader properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
Setting BenchCel Microplate Handler properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38
Setting Bravo Platform properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Setting Stacker properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
Setting Direct Drive Robot properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47
Setting BenchBot properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

3.   Specifying pipette speed and accuracy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55
About liquid classes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56
Opening the Liquid Library Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58
Creating a liquid class  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59
Calibrating the pipettor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

4.   Tracking and managing labware in storage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65
About labware inventory management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66
Connecting to the inventory database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
Opening the Inventory Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71
About inventory groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73
Creating and managing location groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76
Creating and managing plate groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  78
Adding labware information in the inventory database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81
Moving labware between storage devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  91



Contents

iv VWorks Automation Control Setup Guide

Removing labware information from the inventory database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95
Using a plate group to process labware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  100
Creating a plate group with a barcode input file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  105
Inventory Editor views and filters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  108
Auditing plate volumes in the Inventory Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110
Reinventorying the labware inventory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112
Exporting and importing the inventory data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114
Resolving labware inventory problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117

5.   Planning and managing user accounts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119
Planning user accounts and privileges . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
Managing user accounts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121

A.  Setting up a Windows 7 MySQL database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  123
Installing and setting up MySQL 5.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124
About uninstalling MySQL  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  131

B.  Setting up a Windows 10 MySQL database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  133

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145



v

VWorks Automation Control
Setup Guide

Agilent Technologies

Preface

This preface contains the following topics:

• “About this guide” on page vi

• “Accessing Automation Solutions user guides” on page viii
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About this guide

Who should read this guide

Job roles

This user guide is for people with the following job roles:

 

What this guide covers 

This guide describes how to:

• Install the VWorks software

• Define labware

• Specify pipette speed and accuracy

• Track and manage labware using a database inventory system

• Manage user accounts

This guide does not provide instructions for writing protocols, running 
protocols, troubleshooting protocols, or operating devices using the VWorks 
software. For information about these topics, see the VWorks Automation 
Control User Guide, relevant Agilent Technologies device user guide or third-
party user documentation.

Software version

This guide describes VWorks Automation Control 13.0 and later versions.

The software runs on the Microsoft Windows 7 64- bit or Windows 10 operating 
system.

Job role Responsibilities

Integrator Someone who writes software and configures hardware 
controlled by VWorks software.

Lab manager, 
administrator, or 
technician

Someone who is responsible for:

• Developing the applications that are run using 
VWorks software

• Developing training materials and standard 
operating procedures for operators

Operator Someone who performs the daily production work 
using VWorks software and solves routine problems.

Your organization may choose to create its own 
procedures for operators including the procedures in 
this guide.
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IMPORTANT If using Windows 10, the computer display must be set to a 
scale of 100% to ensure the VWorks software displays properly.

Related guides

The VWorks Automation Control Setup Guide should be used in conjunction 
with the following guides, which are available in the VWorks Knowledge Base:

• VWorks Automation Control User Guide

• Agilent Technologies device user guides

• Third- party device user documents

The VWorks Bravo Platform for Windows Non- Administrators Setup Guide 
describes how to set up user accounts that can be shared across multiple 
computers and configure the VWorks Automation Control software so that 
Windows users with non- Administrator privileges can use the VWorks software 
to operate the Bravo Automated Liquid Handling Platform.

Related information

For information about... See...

Accessing user documentation 
in the VWorks Knowledge Base

“Accessing Automation Solutions 
user guides” on page viii
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Accessing Automation Solutions user guides

About this topic

This topic describes the different formats of user information and explains how 
to access it for the Agilent Automation Solutions products.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent website. You can search the online knowledge base or download the 
latest version of any PDF file from the Agilent website at www.agilent.com/
chem/askb. 

Accessing safety information

Safety information for the Automation Solutions devices appears in the 
corresponding device safety guide or user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:

• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

http://www.agilent.com/chem/askb
http://www.agilent.com/chem/askb
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you to search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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Installing and setting up the VWorks 
software 

This chapter contains the following topics:

• “Installing and uninstalling the software” on page 2

• “Logging in and setting up the software” on page 3

• “Reporting problems” on page 5
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Installing and uninstalling the software

About this topic

This topic describes how to install the VWorks Automation Control software 
(VWorks software). The VWorks software manages and controls standalone 
devices and integrated devices in a laboratory automation system. 

For the computer requirements, see the VWorks software release notes.

If you encounter problems after installing the software, try to locate a solution 
using the guidelines in one of the following documents:

• VWorks Automation Control User Guide

• Applicable user guide for your device

If you are unable to resolve the problem, see “Reporting problems” on page 5.

Installing the software

If you have a previous version of the VWorks software, you must first uninstall 
it before installing the new software. 

To install the software:

1 Insert the VWorks software CD into the computer CD- ROM drive. The 
software installer should start automatically. 

If installer does not start, navigate to the CD- ROM drive, and then double-
click VWorks_x.x.x.exe.

2 Follow the instructions that appear on the screen.

Uninstalling the software

To uninstall the VWorks software:
Uninstall the VWorks software using the applicable uninstall apps or programs 
feature in Microsoft Windows 7 or 10. The removal process might take a few 
minutes.

When the removal process is finished, the following folders and files may 
remain depending on the version of the VWorks software:

...\VWorks folder:

• Users folder

• VWorks.vln file (This file is installed by earlier versions than VWorks 
software 13.0.)

...\VWorks Workspace folder:

• Barcode Input Files folder

• Protocol Files folder

• Device Files folder

• RunSet Files folder

• Scripts folder

• VWorks folder
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Typically, uninstalling the VWorks software without removing the registry files 
is sufficient. However, you can remove the Automation Solutions files from the 
registry if you do not intend to run the VWorks software on the computer 
again, or if you want a completely fresh start with VWorks software. For 
assistance, contact Agilent Automation Solutions Technical Support.

Related information

Logging in and setting up the software

Logging in the first time

To log in the VWorks software:

1 Start the VWorks software. To do this, double- click the VWorks icon on the 
Windows desktop.

2 In the VWorks window that opens, click Log in on the toolbar.

The User Authentication dialog box opens.

3 Log in as administrator.

VWorks setup workflow

If you are setting up the software for the first time, use the following 
workflow:

For information about... See...

Setting up the software “Logging in and setting up the 
software” on page 3

Reporting a problem “Reporting problems” on page 5
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Step For this task... See...

1 Set up user accounts. 

You can set up different user accounts 
to enforce access policies.

“Planning and managing 
user accounts” on 
page 119

2 Create labware definitions for the 
labware you will use during protocol 
runs.

“Defining labware” on 
page 7

3 If you have a Bravo Platform or Vertical 
Pipetting Station, specify the pipetting 
speed and accuracy.

The Liquid Library Editor provides tools 
for specifying properties that affect 
pipetting speed, accuracy, and precision.

“Specifying pipette speed 
and accuracy” on page 55

4 Set up the devices. 

During setup, you add the standalone or 
integrated devices in the software and 
establish communication with the 
device.

Device user guide

5 If you have a labware storage device, 
such as the Labware MiniHub, manage 
the labware inventory. 

The Inventory Editor helps you track 
barcodes and labware as you move them 
into and out of storage or incubation.

“Tracking and managing 
labware in storage” on 
page 65

6 Create protocols. 

Protocols determine the sequence of 
tasks you want to automate in a run. 
For example, you can use a protocol to 
apply barcode labels to 100 microplates.

VWorks Automation 
Control User Guide
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Reporting problems 

Contacting Automation Solutions Technical Support 

Note: If you find a problem with the VWorks software, contact Automation 
Solutions Technical Support. For contact information, see Notices on the back 
of the title page. 

Note: You can also send a software bug report from within the VWorks 
software.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready. See the device user guide for the location of the label.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Software version number

• Error message text (or screen capture of the error message dialog box)

• Screen capture of the About VWorks software dialog box

• Relevant software files

To find the VWorks software version number:

In the VWorks software, select Help > About VWorks.

To find the Diagnostics software version number:

1 Open Diagnostics.

2 Read the version number on the title bar of the diagnostics window.

To send compressed protocol and associated files in VZP format:
In the VWorks software, select File > Export to export and compress the 
following files:

• Protocol file

• Device file (includes the device profile and teachpoint file)

• Labware definitions

• Liquid classes

• Pipette techniques

• Hit- picking files

• Plate map files

• Barcode files

• Error library

• Log files

• Form file (*.VWForm)
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Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments using one of the following methods:

• Click the feedback button ( ) in the online help.

• Send an email to documentation.automation@agilent.com.
 

Related information

For information about... See...

Troubleshooting problems with the 
VWorks software

VWorks Automation Control User 
Guide

Troubleshooting problems with a 
device controlled by the VWorks 
software

Applicable user guide for the device

mailto:documentation.automation@agilent.com
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Defining labware

This chapter contains the following topics:

• “About defining labware with the Labware Editor” on page 8

• “Labware Editor overview” on page 9

• “Workflow for defining labware” on page 13

• “Opening the Labware Editor” on page 15

• “Adding a labware entry” on page 17

• “Setting general properties” on page 20

• “Setting microplate properties” on page 22

• “Setting tip and well properties for pipetting” on page 28

• “Creating and assigning labware classes” on page 30

• “Using labware classes example” on page 33

• “Adding a labware image” on page 36

• “Setting Centrifuge Loader properties” on page 37

• “Setting BenchCel Microplate Handler properties” on page 38

• “Setting Bravo Platform properties” on page 42

• “Setting Stacker properties” on page 44

• “Setting Direct Drive Robot properties” on page 47

• “Setting BenchBot properties” on page 50
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About defining labware with the Labware Editor

Labware defined

Labware is a physical object such as a microplate, lid, or tip box that will be 
acted upon by the tasks stored in your protocol.

The VWorks software requires all labware that will be handled by the 
automation system to be defined in the labware database.

Labware entry defined

A labware entry is the collection of properties or parameter values that 
describe a specific type of labware. This information is used by the VWorks 
software to command the robot and other devices to do tasks based on the 
information in the definition.

All labware parameters are entered and accessible through the Labware Editor.

Labware Editor defined

The Labware Editor is the VWorks software interface through which you can 
enter information about labware.

You must be logged in as an administrator or technician to use the Labware 
Editor.

Types of information stored

Two main types of information are stored in the labware database:

• Information about the labware properties

• Information about labware classes

About labware properties or parameters

Labware has physical properties such as width, length, and number of wells. 
Labware can also have non- physical properties, such as robot- handling speed, 
robot grip offsets, and microplate- handling options.

After labware is defined in the Labware Editor, all you have to do is select the 
type of labware to use each time you set up a protocol.

About labware classes

Labware classes are sets of labware entries, grouped so they are easier to 
manage than many individual labware entries.

Labware classes are used in combination with the device manager to restrict 
which types of labware can be used on which devices during a protocol run. 
This prevents wasted runs and damage to the devices on the platform.

An example of how damage can be prevented by labware restriction is where a 
tip box that is too tall for a device crashes into the device as the robot 
delivers it. 
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Related information

Labware Editor overview

Labware Editor tabs

The Labware Editor has two tabbed pages:

• Labware Entries. Provides tools for creating and editing labware 
definitions

• Labware Classes. Provides tools for creating and editing labware classes 
and the labware entries for each class. 

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Overview of the Labware Editor “Labware Editor overview” on page 9

Opening the Labware Editor “Opening the Labware Editor” on 
page 15
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Labware Entries tab
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Sub-tabs
The Labware Entries tab contains the following sub- tabs that contain the 
properties associated with a labware entry.

Labware selection list
The labware selection list, which is the left- hand column, displays the list of 
labware definitions and allows you to select the labware entry that you want 
to edit.

Labware-Entry General Properties area
The Labware- Entry General Properties area displays the labware properties 
that apply across all sub- tabs.

To find out more about… See…

Plate Properties tab “Setting microplate properties” on page 22

Pipette/Well Definition tab “Setting tip and well properties for pipetting” 
on page 28

Labware Classes tab “Using labware classes example” on page 33

Image tab “Adding a labware image” on page 36

Centrifuge Loader tab “Setting Centrifuge Loader properties” on 
page 37

BenchCel tab “Setting BenchCel Microplate Handler 
properties” on page 38

Bravo tab “Setting Bravo Platform properties” on 
page 42

Stacker tab “Setting Stacker properties” on page 44

Direct Drive Robot tab “Setting Direct Drive Robot properties” on 
page 47

BenchBot tab “Setting BenchBot properties” on page 50
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Labware Classes tab

You use the Labware Classes tab to create labware classes and assign defined 
labware to a labware class.

Related information

For information about... See...

The Labware Editor “About defining labware with the 
Labware Editor” on page 8
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Workflow for defining labware

Labware standards and considerations

IMPORTANT All labware used with Agilent Technologies products must 
conform to the American National Standards Institute (ANSI) microplate 
standards. This includes deepwell and PCR plates. A group within the Society 
for Biomolecular Sciences (SBS) recommends and maintains the standards. 
Visit www.sbsonline.org for more information, or contact your labware's 
manufacturer.

Vertical Pipetting Station users. In addition to the ANSI standards for 
labware, Vertical Pipetting Station shelves 1 and 2 have a height restriction to 
ensure clearance for the pipette head. The maximum height of the labware that 
you can use on shelves 1 and 2 depends on several factors, such as the type of 
pipette head, tip size, and type of shelf. 

Note: The software displays an error message if you select a labware definition 
that exceeds the maximum allowable height for shelves 1 and 2. 

Workflow

The following table presents the sequence of steps to define labware for 
devices that use the VWorks software.

Note: Some of these steps may be omitted, depending on your system 
configuration.

Workflow for defining labware in 
the Labware Editor

“Workflow for defining labware” on 
page 13

For information about... See...

Step For this task... See...

1 Add the labware entry to the 
Labware Editor.

• “Opening the Labware Editor” 
on page 15

• “Adding a labware entry” on 
page 17

2 Set the general properties of 
the labware.

“Setting general properties” on 
page 20

3 Set the microplate properties. “Setting microplate properties” on 
page 22

4 Bravo Platform or Vertical 
Pipettor only. Set the pipetting 
properties.

“Setting tip and well properties for 
pipetting” on page 28

5 Assign the labware to a class. “Creating and assigning labware 
classes” on page 30
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Related information

6 Optional. Add a labware image. “Adding a labware image” on 
page 36

7 Centrifuge Loader only. Set 
the robot gripper offset if using 
a Centrifuge Loader.

“Setting Centrifuge Loader 
properties” on page 37

8 BenchCel Microplate Handler 
only. Set the robot and stacker 
gripping positions. 

“Setting BenchCel Microplate 
Handler properties” on page 38

9 Bravo Platform only. Set 
properties for the Bravo 
gripper, if applicable.

“Setting Bravo Platform properties” 
on page 42

10 BenchCel Microplate Handler 
and Labware Stacker only. Set 
the gripper and sensor settings 
and any microplate notch 
positions.

“Setting Stacker properties” on 
page 44

11 Direct Drive Robot only. Set 
the robot gripper offsets and 
the grip force.

“Setting Direct Drive Robot 
properties” on page 47

12 BenchBot only. Set the robot 
gripper offsets and the grip 
force.

“Setting BenchBot properties” on 
page 50

13 Save a new or edited labware 
entry.

“Adding a labware entry” on 
page 17

Step For this task... See...

For information about... See...

The Labware Editor • “About defining labware with the 
Labware Editor” on page 8

• “Labware Editor overview” on 
page 9

Opening the Labware Editor “Opening the Labware Editor” on 
page 15
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Opening the Labware Editor

About this topic

You use the Labware Editor when you want to view, add, delete, edit, or 
rename labware entries or labware classes. This topic explains how to open the 
Labware Editor from the Tools menu and protocol editor in the VWorks 
software. See the device user guide for details on how to open the Labware 
Editor from the device diagnostics software. 

Before you start

You must be logged in as an administrator or technician to open the Labware 
Editor.

If you are adding labware, make sure you have the following:

• Calipers

• Two samples of the labware you are adding

Procedure

To open the Labware Editor from the Tools menu:

In the VWorks window, choose Tools > Labware Editor. The Labware Editor 
window opens.
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To open the Labware Editor from the protocol editor:

1 Open a protocol file (File > New > Protocol or File > Open). This opens the 
Main Protocol area with Process- 1 and a list of Plate properties in the 
Task Parameters area. 

Note: If the Task Parameters area is empty, click Add Process in the Main 
Protocol area.

2 Select Edit labware from the Plate type list under Plate identity. 

Related information

For information about... See...

The Labware Editor • “About defining labware with the 
Labware Editor” on page 8

• “Labware Editor overview” on 
page 9

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Adding a labware entry “Adding a labware entry” on page 17
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Adding a labware entry 

Before you start

You must be logged in as an administrator or technician to perform this 
procedure.

Before you add a new labware entry:

• Check to see if it is already defined in the Labware Editor. 

Some common labware and some Agilent Technologies labware comes 
already defined in the VWorks software.

• Contact Automation Solutions Technical Support with the definition you 
need.

Automation Solutions Technical Support maintains a large collection of 
labware definitions and might be able to supply you with what you need. 
However, these labware definitions will still require some fine- tuning for 
each particular system. The generic definitions available for some 
microplate types are a good starting point.

To find out if a type of microplate is already defined:

1 In the VWorks window, click Main Protocol, and select the microplate icon in 
a process.

2 In the Plate identity area, click the Plate type list and look for the microplate 
name.

If the list does not contain an entry for the microplate type, it is not yet 
defined.
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Procedure

To add a labware entry:

1 Open the Labware Editor.

2 In the Labware Entries tab, click New labware entry at the bottom left of the 
window.

Note: You can save time by using a definition for a similar labware type 
as a template. Select the pre- existing definition in the list, click Save 
changes as, and enter a name for the new labware definition.

3 In the New Labware Entry dialog box, type a name for the labware type, and 
click OK. The new entry appears in the labware list. 

For clarity, enter a detailed name for the labware that includes labware-
specific information. For example, the name should include the number of 
wells, the manufacturer’s name and part number, and descriptive terms, 
such as square- well, flat- bottom or tip box.

 IMPORTANT If you plan to use a .csv file to import labware into an 
inventory database, avoid using any commas in the name that you 
assign to the labware entry in the Labware Editor.

To save the labware entry:

1 Edit the properties as appropriate for the labware type. See “Workflow for 
defining labware” on page 13.

2 Click Save changes to save the newly defined labware entry.
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Related information

For information about... See...

The Labware Editor • “About defining labware with the 
Labware Editor” on page 8

• “Labware Editor overview” on 
page 9

Plate Properties tab “Setting microplate properties” on 
page 22

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Opening the Labware Editor “Opening the Labware Editor” on 
page 15
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Setting general properties

About general properties

The general properties describe the type of labware that is being entered into 
the database and are visible on all of the sub- tabs of the Labware Editor.

Before you start

• You must be logged in as an administrator or technician to perform this 
procedure.

• You must first create an entry for the labware.

Procedure

To define the general properties of a piece of labware:

1 Open the Labware Editor.

2 In the Labware Entries tab, select the labware from the list.

3 Under Labware-Entry General Properties, type a detailed description of the 
labware in the Description box.

4 In the Manufacturer part number box, type the appropriate number for your 
reference. 

5 In the Number of wells list, select the number of wells in the microplate. 
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If you are defining a tip box, this is the number of tips that the box can 
hold.

6 In the Base Class area, select one of the options.

The option you select determines which Labware Editor properties are 
available. For example, when a base class of Microplate is selected, the 
Length of filter tip/pin tool (mm) property is unavailable.

Note: The Pin tool base class is not used.

Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Setting microplate properties for 
labware

“Setting microplate properties” on 
page 22
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Setting microplate properties

Before you start

You must have a technician or administrator user account to perform this 
procedure.

Setting microplate properties

To set microplate properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the Plate Properties sub- tab.

Figure Plate Properties sub-tab

3 Enter the values for the available parameters according to the labware type 
you are defining. The following table describes each parameter.

Note: The Base Class you select in the General Properties section 
determines which microplate properties are available.
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Parameter Description

Robot gripper 
offset (mm)

Note: Applies to the 3- Axis Robot in the BioCel Systems 
only. The Direct Drive Robot ignores this value, and uses 
the gripper offset values on the Direct Drive Robot tab.

The height (mm) of the gripper above any teachpoint 
when the robot is picking up or placing a microplate of 
this type. The value is typically 0–3 mm.

Note: The offset could be a negative value, indicating it is 
below the teachpoint.

This parameter is used by the VWorks software when 
running protocols. The gripper offset parameter in the 
device Diagnostics software performs the same function 
when picking and placing labware using commands in 
the Diagnostics software.

Thickness 
(mm)

The distance from the bottom of the microplate skirt to 
the top of the microplate.

For a tip box, this is the distance from the bottom of the 
box to the top of the tips.

For a filter plate that has filter nozzles that extend below 
the skirt, measure the distance from the bottom of the 
filter plate skirt to the top of the filter plate. You will 
use the parameters in the Miscellaneous section to 
account for the filter nozzles.

Figure Example of the thickness measurement for a filter plate

To increase the number of contact points, measure the 
distance at the corner of the microplate or tip box (using 
calipers). This method prevents the calipers from angling 
inward, which can produce inaccurate measurements.
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Stacking 
thickness 
(mm)

The thickness of two stacked microplates of the same 
type minus the thickness of one microplate.

Measure the distance using calipers.

Example:

Thickness of two stacked microplates (x) = 23.14 mm

Thickness of one microplate = 14.14 mm

Stacking thickness: 23.14 mm -  14.14 mm = 9.00 mm

Lid depth 
(nm)

The height of the lid interior, which is measured from 
the bottom resting surface of the lid to the underside of 
the lid’s top surface.

Can be 
sealed?

The option to include the microplate seal. 

Sealed 
thickness 
(mm) 

The thickness of the microplate with a seal in place.

Available only if Can be sealed? is selected.

Sealed 
stacking 
thickness 
(mm)

The stacking thickness of the microplate with a seal in 
place.

Available only if Can be sealed? is selected.

Can have lid? The option to include a microplate lid.

Lidded 
thickness 
(mm)

The thickness of the microplate with a lid in place.

Available only if Can have lid? is selected.

Lidded 
stacking 
thickness 
(mm)

The stacking thickness of the microplate with the lid in 
place.

Available only if Can have lid? is selected.

Parameter Description

Vstack
plate and stacking thickness
00022

Plate Thickness

Stacking Thickness

x

00022
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Lid resting 
height (mm)

The height (c) above the bottom of the microplate (d) at 
which the bottom of a microplate lid rests. 

IMPORTANT If you are using the Direct Drive Robot in 
your automation system, be aware that the Lid resting 
height parameter works with the gripper offset range 
parameters. If you select the Plates have lids option in the 
Plate identity area in the protocol, the software 
automatically subtracts the thickness of the robot gripper 
fingers from the lid resting height to avoid gripping the 
lid. If the gripper offset range does not overlap with this 
value, an error will occur during the run.

For example, suppose the Lid resting height is 9.8 mm, and 
the Direct Drive Robot gripper finger thickness is 
4.5 mm. Because you selected the Plates has lids option, 
the software will calculate the difference, which is 
5.3 mm. However, the specified gripper offset range is 6–
10 mm. 5.3 mm is outside of the range, so an error will 
occur.

Lid departure 
height (mm)

The height (e) above the lid resting height to which the 
lid is lifted. In the BenchCel Microplate Handler, the lid 
is lifted to this height, and then the lid is removed.

Plate Handling 

Lower plate 
at Microplate 
Labeler

The option to lower the Microplate Labeler stage if the 
microplate has a tall skirt or a raised surface in the 
middle of each side. Lowering the stage allows the 
Microplate Labeler to place the label above the tall skirt 
or raised surface.

Note: The two vertical plate stage positions are set 
mechanically. To adjust the positions, see the Microplate 
Barcode Labeler User Guide for instructions.

Can mount The option to place this microplate on top of another 
microplate.

This property is for filter plates that are placed on top 
of waste plates during filtration steps of a protocol.

This option can also be used to mount lids onto 
microplates.

Parameter Description

c
d

e
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Can be 
mounted

The option to place another microplate on top of this 
microplate.

This property is for collection microplates that collect 
filtrate from filter plates during the filtration steps of a 
protocol. Many different microplates might be able to fit 
under any one type of filter plate. 

IMPORTANT The wells of the waste plate must have a 
large enough diameter that the filter plate does not stick 
on the waste plate. The robot must be able to pick up 
the filter plate without the waste plate lifting up with it.

This option can also be used to mount lids onto 
microplate.

Maximum Robot Handling Speed

Maximum 
robot 
handling 
speed

The maximum speed at which the robot can move this 
type of microplate.

In addition to this microplate- specific speed, you set the 
general robot speed via the Tools > Options menu in the 
VWorks software. If these speeds are different, the robot 
uses the slower of the two speeds.

Note: To increase throughput, you can use a higher speed 
when the robot is not carrying labware. For details, see 
the VWorks Automation Control User Guide.

Miscellaneous

Length of 
filter tip/pin 
tool (mm) 

Available for labware of the Filter plate or Pin tool Base 
Class only.

The length of the pins that protrude below the pin tool 
head, or the distance that the filter nozzle extends below 
the bottom edge of the filter plate skirt. Use a caliper to 
measure the length.

Figure Length of filter tip

Parameter Description



27

2   Defining labware
Setting microplate properties

VWorks Automation Control Setup Guide

Related information
 

Filter channel 
resting depth

Available for labware of the Filter plate Base Class only.

The distance from the tip of the protruding filter nozzles 
to the point at which the filter plate rests on another 
plate. Use a caliper to measure the distance.

Figure Filter plate channel resting depth

Figure Filter channel resting depth (filter plate on microplate

The software uses this parameter to calculate the 
effective height (Zg- axis) of the gripper and ensure 
sufficient clearance when gripping and moving the filter 
plates. 

Requires 
insert

The option to require an insert for use with nestable tip 
boxes.

Parameter Description

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Setting general properties for 
labware

“Setting general properties” on page 20

Setting Direct Drive Robot 
properties for labware

“Setting Direct Drive Robot properties” 
on page 47
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Setting tip and well properties for pipetting

When to set the pipetting properties

If the VWorks software is controlling a Vertical Pipetting Station or a Bravo 
Platform, you must set the properties for the labware type in the Pipette/Well 
Definition sub- tab. 

Setting properties

To set pipette/well properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the Pipette/Well Definition sub- tab.

Figure Pipette/Well Definition sub-tab

3 Enter the values for the available parameters according to the labware type 
that you are defining. The following table provides a description of each 
parameter. 

 IMPORTANT Use calipers to carefully measure the labware you are 
defining in the Labware Editor.

Parameter Description

Well volume Maximum volume (µL) of fluid for one well.

Well depth Distance (mm) from the top of the microplate to 
the bottom of the well.

Well diameter Diameter of the well (mm).

Well Geometry Shape of the wells: round or square.
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Related information

Well- Bottom Shape Shape of the well bottoms: rounded, flat, or 
V- shaped.

Row- wise 
teachpoint to well

Distance (mm) from the teachpoint to the center of 
the A1 well along the row (letter axis). 

This setting should be 0 mm for standard 96- well 
microplates and 2.25 mm for standard 384- well 
microplates.

Column- wise 
teachpoint to well

Distance (mm) from the teachpoint to the center of 
the A1 well along the column (number axis). 

This setting should be 0 mm for standard 96- well 
microplates and 2.25 mm for standard 384- well 
microplates. 

Row- wise well to 
well

Distance (mm) from well- center to well- center 
across the row. 

This setting should be 9 mm for standard 96- well 
microplates and 4.5 mm for standard 384- well 
microplates. 

Column- wise well 
to well

Distance (mm) from well- center to well- center 
across the column. 

This setting should be 9 mm for standard 96- well 
microplates and 4.5 mm for standard 384- well 
microplates. 

Disposable tip 
capacity

Volume capacity (µL) of the disposable tips when 
labware is a tip box. 

Disposable tip 
length

Length (mm) of the disposable tips being used 
when labware is a tip box.

Parameter Description

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Setting general properties for 
labware

“Setting general properties” on page 20

Setting microplate properties for 
labware

“Setting microplate properties” on 
page 22
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Creating and assigning labware classes

About labware classes 

When you configure a device for the VWorks software, you can associate the 
device with labware classes to indicate what labware can (and cannot) be used 
with the device. Associating a device with a labware class is performed in the 
device file under the Allowed/prohibited labware property.

For example, if you have a Microplate Vacuum Alignment Station on a Bravo 
platform, you might want to set up a labware class from which tube racks are 
excluded. (Most types of tube racks will cause an error on the Microplate 
Vacuum Alignment Station).

VWorks software is provided with six labware classes already defined: 

• Uses Filter Platepad

• Uses Standard Platepad

• Uses Taller Plate

• Uses Tip Box

• Uses Vacuum Delidder

• Uses Vacuum Platepad

These default classes should be enough for your microplate handling needs. 
However, if you want an additional special class that is excluded from a 
particular device or set of devices, you can create a new class.

About creating and assigning labware classes

The Labware Classes tab in the Labware Editor provides the tools for creating 
and managing labware classes and labware entry membership. 

Select a class (in the left- most column) to see the labware entries that are 
members and non- members for that class (right two columns). In the example 
below, the class Uses Filter Platepad is selected and the labware that are 
members and non- members of this class are displayed.
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Creating labware classes

To create a new labware class:

1 Open the Labware Editor.

2 In the Labware Classes tab, click New labware class.

3 In the New Labware Class dialog box, enter a name for the labware class and 
click OK.

The class appears in the list of labware classes. 

Note: You can also create a new labware class by clicking Save changes as and 
entering a different name.

Assigning labware classes

To associate a specific piece of labware with a labware class:

1 Open the Labware Editor.

2 In the Labware Classes tab, select an item from the middle column.

3 Click > to move the labware entries or labware classes to the right- hand 
column.
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To select more than one item, use SHIFT+click or CTRL+click. If you want 
to move all entries, click >>. 

4 Click Save Changes to save your changes. 

Note: You can also assign labware to a class using the Labware Classes tab on 
the Labware Entries tab. This may be more convenient when you are defining 
a new piece of labware and want to assign it to an existing labware class.

Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

An example demonstrating the use 
of labware class

“Using labware classes example” on 
page 33
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Using labware classes example

Example

You have configured shelves 2, 4, and 6 of a Vertical Pipettor as devices that 
are accessible by the system’s robot. You are using a mix of microplates, some 
of which are too tall to fit on shelf 2. By using labware classes, you will 
ensure that the robot will never try to place the wrong type of labware on 
shelf 2.

The labware has been defined and added to the Labware Editor but it still has 
the default settings for class membership. 

You need to:

1 Assign the tall labware to the appropriate labware class.

2 Restrict shelf 2 from using any labware that is a member of the Uses Taller 
Plates class.

Assigning the labware to a labware class

To assign the labware:

1 Open the Labware Editor.

2 In the Labware Entries tab, select the labware from the list, and then click 
the Labware Classes sub- tab. The classes that the labware are and are not a 
member of is displayed.

3 Select Uses Taller Plates from the All labware classes area, and then click > to 
move the class to the Labware classes that this labware entry belongs to area.

4 Click Save changes.
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Setting restrictions for shelf 2

To restrict shelf 2:

1 In the VWorks window, open the device file, and ensure the correct Vertical 
Pipetting Station device is selected.

2 In the Devices list under Vertical Pipetting Station, select Shelf 2.

3 Under Shelf 2 Location Properties, click the Allowed/prohibited labware field, and 
then click the  button. The Allowed/Prohibited Labware Classes dialog 

box opens.

4 In the Unassigned labware classes area, select Uses Taller Plates, and then 
click < to move it to the Labware classes prohibited from using this device area.

5 Click OK.
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Figure VWorks software main window (partial) and Allowed/Prohibited Labware Classes 
dialog box

Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Labware classes “Creating and assigning labware 
classes” on page 30
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Adding a labware image

About labware images

To make it easier for operators to identify a labware type, you can insert an 
image of it in the Labware Editor.

Before you start

Make sure the image file you want to add is either the JPG, GIF, or BMP 
format.

Procedure

To insert an image:

1 Open the Labware Editor.

2 In the Labware Entries tab, select the labware in the left column, and then 
click the Image sub- tab. 

3 At the Image filename box, click the  button to locate the file.

4 In the Open dialog box, select the image file and click Open.

The image appears below the file name.

5 Click Save changes.
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Related information

Setting Centrifuge Loader properties

When to set Centrifuge Loader properties

If you are operating a Centrifuge with a Centrifuge Loader, set the 
corresponding properties in the Centrifuge Loader sub- tab of the Labware 
Editor.

You must be logged in as an administrator or technician to perform this 
procedure.

Procedure

To set Loader properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the Centrifuge Loader sub- tab.

3 In the Robot gripper offset (mm) box, type the distance from the bottom of 
the microplate where the robot can grip the microplate.

4 Optional. Select the Ignore plate sensor during pick and place check box if you 
want to ignore the microplate sensor, for example if you are using a black 
microplate that has a finish and skirt that would otherwise avoid detection.

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Using the Labware Editor “Labware Editor overview” on page 9

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Using the Labware Editor “Labware Editor overview” on page 9
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Setting BenchCel Microplate Handler properties

About the BenchCel Microplate Handler properties

The BenchCel Microplate Handler X- Series and R- Series each have their own 
gripper offsets and positions. When you add a new labware entry, default 
parameter values are automatically inserted for both series. These values are 
approximate and should be ignored because the labware you are defining may 
be different.

Any labware that you are using with the X- Series must be redefined to work 
with the R- Series BenchCel Microplate Handler because the parameter values 
are different for the same piece of labware. 

Note: You must also define a subset of the Stacker properties (under the 
Stacker sub- tab) because they apply to the built- in stackers of the BenchCel 
Microplate Handler.

Procedure

To define the BenchCel Microplate Handler properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the BenchCel sub- tab.

Figure BenchCel sub-tab

3 Click the button that corresponds to the BenchCel Microplate Handler type 
that is currently operating and for which you are defining the labware.
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 IMPORTANT Make sure you enter values for the correct model of the 
BenchCel Microplate Handler. Fields for X- Series and R- Series BenchCel 
Microplate Handlers can be enabled regardless of the type of BenchCel 
Microplate Handler that you are operating.

4 Measure the labware and enter the values for the following fields.

Parameter Description

Robot gripper offset 
(mm)

The distance from the bottom of a microplate to 
where the robot grippers will hold the microplate.

IMPORTANT Make sure that the gripper points 
do not close at the edge of the skirt. Otherwise, 
the gripper can slip onto the body of the 
microplate and drop the microplate.

Gripper open position 
(mm)

The distance the grippers move from the home 
position as the robot releases a microplate. A 
larger value moves the grippers closer together. A 
smaller value opens the grippers wider.

Set this to –1 for R series and 0.1 for X Series 
BenchCel Microplate Handlers.

Gripper holding plate 
position (mm)

The distance that the grippers move inward from 
their home position when holding a microplate 
that is not in a stack. A larger value moves the 
grippers closer together and holds the microplate 
tighter. A smaller value opens the grippers wider.

Note: How tightly the robot grippers should hold a 
microplate depends on the microplate material 
and design. You might want to run some tests to 
optimize the parameter.
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Gripper holding lidded 
plate position (mm) 

The distance that the grippers move inward from 
home position when holding a lidded microplate. 

An increasing value moves the grippers closer 
together and holds the lidded microplate tighter. 
A decreasing value opens the grippers wider.

Gripper holding lid 
position (mm)

The distance the grippers move inward from 
home position when holding a microplate lid. 
Increasing the value moves the grippers closer 
together and holds the lid tighter. Decreasing the 
value opens the grippers wider.

In general, type a value that is less than Gripper 
holding plate position to open the grippers 
slightly. Holding the lid too tightly might cause 
the microplate to be lifted with the lid.

Gripper holding stack 
position (mm)

The distance the grippers move inward from the 
home position when holding a microplate that is 
in a stack. A larger value moves the grippers 
closer together and holds the microplate tighter. A 
smaller value opens the grippers wider.

Note: Because the weight of the entire stack will 
be on the robot grippers, you should use a value 
greater than the Gripper holding plate parameter.

Lid gripper offset (mm) The height (a) above the lid resting height (b) at 
which the gripper can grip the lid.

Stacker gripper offset 
(mm)

The distance from the bottom of a microplate to 
where the stacker grippers will hold the 
microplate.

Be careful not to grab the microplate on the top 
edge of the skirt where the stacker grippers could 
slip onto the microplate body.

Change this value only if the stacker is not 
gripping the microplates correctly.

Parameter Description

b
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Related information

Orientation sensor offset 
(mm)

The distance from the bottom of a microplate to 
where the orientation sensors will check for 
notches. 

You can calculate the initial offset as follows: 
Determine the halfway distance between the top 
of the microplate and the top of the microplate 
skirt, and then add the height of the skirt.

See the BenchCel Microplate Handler User Guide 
for details on how to determine the optimum 
Orientation sensor offset. 

Stack holding method R- Series only. The option that specifies how the 
stacker holds the stack of microplates: 

• Hold with stacker gripper. For the greatest 
precision, select this method, for example, if 
your microplate has a narrow gripping 
tolerance requiring a specific stacker gripper 
offset. Holding the stack with grippers results 
in slower cycle time than the Hold with shelf 
method.

• Hold with shelf. For faster cycle time, select 
this method if your microplate has a wider 
gripping tolerance and does not require a 
specific stacker gripper offset.

Parameter Description

Divide this height by 2

Add the skirt height

For information about... See...

Using the Labware Editor “Labware Editor overview” on page 9

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Setting general properties for 
labware

“Setting general properties” on page 20
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Setting Bravo Platform properties

When to set Bravo properties

If you are operating a Bravo Platform that has a robot gripper, use this 
procedure to ensure that the parameter values are set correctly.

Note: The Bravo robot gripper is an optional feature.

You must be logged in as an administrator or technician to perform this 
procedure.

Procedure

To set Bravo Platform properties:

1 Open the Labware Editor.

2 In the Labware Entries tabs, click the Bravo sub- tab.

3 Under Gripper Offset and Positions, type the Robot gripper offset. This is the 
height (mm) of the gripper above any teachpoint when the Bravo gripper is 
picking up or placing a microplate of this type.

4 Enter the Robot lid gripper offset. This is the height (mm) above the lid resting 
height at which to grip the lid. (Shown as b below.)

5 Select Ignore plate sensor during pick and place to tell the robot gripper to 
ignore the feedback from the microplate sensor during a pick and place for 
this labware. Typically, this is selected when troubleshooting.

                                                        

b
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Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Using labware classes “Creating and assigning labware 
classes” on page 30
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Setting Stacker properties

When to set Stacker properties

If you are using a Stacker or a BenchCel Microplate Handler in your 
automation system, you must set the properties in the Stacker sub- tab of the 
Labware Editor.

You must be logged in as an administrator or technician to perform this 
procedure.

Before you start

BenchCel Microplate Handler users. Make sure you have read the sections of 
the BenchCel Microplate Handler User Guide that describe the location and 
function of the stacker sensors.

Setting properties

To set stacker properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the Stacker sub- tab. 

3 Enter the values for the available properties according to the labware you 
are defining. 

BenchCel Microplate Handler only. Set only the maximum orientation 
sensor threshold, sensor intensity, and notch locations. The other settings 
are used by the Stacker.

Figure Properties required for the BenchCel Microplate Handler 
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The following table provides descriptions of each parameter. 

Parameter Description

Stacker only. 
Stacker gripper 
offset 

Adjusts the height at which the microplate stage 
stops for the grippers to grip the microplate, with 
respect to the Stacker’s grip teachpoint.

Change this value only if the stacker is not 
gripping the microplates correctly.

Stacker only. 
Presentation offset 

You should never need to change this value.

Adjusts the height of the Stacker plate stage with 
respect to the presentation teachpoint of a 
Stacker.

Stacker only. 
Orientation sensor 
offset

Adjusts the height at which the orientation 
checking sensors view the microplate, with respect 
to the sensor.

Orientation sensor 
threshold (max)

Specifies the highest value that an orientation 
sensor can register when sensing a notch. Any 
sensor reading above this value indicates that a 
solid microplate wall is present. Any sensor value 
below this threshold indicates that either a notch, 
or no microplate is present.

If the stacker does not sense a notch when it 
should, you will get a “wrong plate type” or a 
“plate rotated 180 degrees” error message. Adjust 
the sensor threshold value.

The maximum value is 255.

Stacker only. 
Orientation sensor 
threshold (min)

Indicates whether a microplate was downstacked 
or is present on the stage.

This threshold specifies the lowest value that an 
orientation sensor can register and still consider a 
notch to be present. 

If the orientation sensor returns a value below 
this threshold, an error message appears stating 
that no microplate is present on the stage.

If the stacker does not sense a notch when it 
should, a “wrong plate type” or a “plate rotated 
180 degrees” error message appears. In this case, 
adjust the sensor threshold value.

Sensor intensity Sets the percentage of maximum sensor intensity 
for all sensors. If the sensor intensity is set too 
low, a microplate will not be detected even though 
one is present. If it is set too high, the sensors 
might become saturated, causing failure to detect 
the orientation of a microplate.

This parameter adjusts for the fact that clear, 
black, and white microplates reflect light 
differently. For example, white microplates 
generally reflect more light so the sensor intensity 
should be set lower. 
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Related information

Stacker only. Use 
vacuum clamp

Instructs theStacker you are using a vacuum 
clamp in the Stacker stage to grasp the microplate 
during delidding.

Notch Locations • Check orientation. Turns on microplate-
orientation checking based on the selected 
notch locations for your microplate. The notch 
locations are ignored when this check box is 
cleared.

• Notch location check boxes. Select the 
corresponding notch or notches for your 
microplate.

For BenchCel Microplate Handlers, the A1 well of 
the microplate is positioned in the far, left corner 
as you face the front of the BenchCel Microplate 
Handler.

For BioCel Systems, the A1 well of the microplate 
is positioned in the far, left corner from the 
perspective of the robot.

IMPORTANT The Stacker has only two 
orientation sensors for detecting notches. If the 
wrong microplate is loaded and an orientation 
sensors detect notches, the sensors will not flag 
an incorrect orientation for the wrong microplate.

IMPORTANT If the orientation sensors detect 
notches in the correct location, the sensors will 
not flag an incorrect orientation for the wrong 
microplate.

Parameter Description

A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Notches

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Using the Labware Editor “Labware Editor overview” on page 9
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Setting Direct Drive Robot properties

When to set Direct Drive Robot properties

If you are using the Direct Drive Robot in your automation system, you must 
specify the robot properties for the labware that the robot will handle. Because 
the weight, material, and design varies, you specify the properties for each 
labware type.

You must have a technician or administrator user account to perform this 
procedure.

About the robot gripper ranges properties

The robot gripper offset range parameters tell the Direct Drive Robot where to 
grip a given labware type when transferring it from one device to another. 
Each device within a system can pose different accessibility challenges when 
transferring the labware. For example, some devices can have a deep, recessed 
area, whereas others are more flat.  Some devices might have tall flanges that 
make it impossible for the robot to grip a microplate at a very low point.

The Direct Drive Robot uses three types of gripper offset ranges to determine 
the most compatible grip position for the labware type:

1 Gripper offset range for the labware. Specified on the Direct Drive Robot 
tab in the Labware Editor for each labware definition. 

2 Gripper offset range for pick- location device. Specified in the DD Robot 
Diagnostics software for a given device (device A).

3 Gripper offset range for place- location device. Specified in the DD Robot 
Diagnostics software for a given device (device B).

If the three gripper offset ranges overlap, the robot will use the smallest 
common gripper offset to perform a direct labware transfer from device A 
to device B without regripping the labware. If the three ranges do not 
overlap, the software attempts to plan a path through one or more regrip 
stations. If the robot cannot perform the transfer, an error message appears 
at the time of the requested labware transfer.

To provide the system with the greatest flexibility for identifying a grip 
position that works for all locations, you should set the widest possible range 
for each gripper offset parameter.
 

Procedure

To set Direct Drive Robot properties:

1 Open the Labware Editor. 

2 In the Labware Entries tab, click the Direct Drive Robot sub- tab.
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Figure Direct Drive Robot sub-tab

3 Enter the values for the following properties according to the labware type 
that you are defining. 

Parameter Description

Landscape 
Orientation 
Gripping Ranges 
(mm) 

The distance from the bottom of the microplate to 
the lowest and highest points where the bottom of 
the robot grippers will be holding the microplate in 
landscape orientation. Default range: 0–10 mm

The minimum and maximum values in the ranges 
depend on the given microplate features and the 
robot gripper fingers you are using. For example, 
suppose you are using standard grippers, which 
are 4.5 mm tall. If the microplate has a 6- mm tall 
skirt, you could set the gripper offset range from 
0 mm to 2.00 mm. At the minimum, the standard 
gripper will be flush with the bottom of the 
microplate. At the maximum, the bottom of the 
gripper will be at 2.00 mm, still permitting the 
robot to grip the microplate securely.

Specifying multiple ranges provides the robot with 
additional grip options. In the following example, 
to avoid the ledge at the top of the skirt, you can 
specify two ranges: one above the skirt and 
another on the skirt.

Use a comma to separate ranges.
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Related information

Portrait Orientation 
Gripping Ranges 
(mm)

The distance from the bottom of the microplate to 
the lowest and highest points where the robot 
grippers can hold the microplate in portrait 
orientation. Default range: 0–10 mm

The minimum and maximum values in the ranges 
depend on the given microplate features and the 
robot gripper fingers you are using. The long sides 
of some microplates have a raised section in the 
middle of each side. In this case, set the minimum 
gripper offset higher than the uneven surface to 
ensure that the robot can grip the microplate 
evenly and securely. The following example shows 
how the range can vary depending on the 
microplate features.

Specifying multiple ranges provides the robot with 
additional grip options. In the following example, 
you can specify three ranges: one above the raised 
section, one at the raised section, and one on the 
skirt.

Use a comma to separate ranges.

Grip torque 
percentage

The grip force with which the robot grips the 
microplate, where 100% is the maximum gripping 
force. A smaller value grips the microplate with 
less force than a greater value.

The force with which the robot can grip a 
microplate depends on the microplate weight, 
material, and design. You should run some tests to 
optimize the setting.

Parameter Description

Range

Range

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13
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Setting BenchBot properties

When to set BenchBot properties

If you are using the BenchBot in your automation system, you must specify the 
robot properties for the labware that the robot will handle. Because the weight, 
material, and design varies, you specify the properties for each labware type.

You must have a technician or administrator user account to perform this 
procedure.

About the labware gripping ranges properties

The labware gripping offset range (Min and Max) parameters tell the VWorks 
software where to grip a given labware type when transferring it from one 
device to another. Each device within a system can pose different accessibility 
challenges when transferring the labware. For example, some devices can have 
a deep, recessed area, whereas others are more flat.  Some devices might have 
tall flanges that make it impossible for the robot to grip a microplate at a very 
low point.

You can set two types of gripper offset ranges:

• Gripper offset range for the labware. Specified on the VWorks software 
tab in the Labware Editor for each labware definition. 

• Gripper offset range for the device. Specified in the VWorks software 
Diagnostics software for a given device.

During a protocol run, the VWorks software uses three gripper offset ranges to 
determine the most compatible grip position for the labware:

• Gripper offset range for the labware

• Gripper offset range for the device (A) where it will pick up the labware

• Gripper offset range for the device (B) where it will place the labware

You should set the widest possible range for each gripper offset parameter. If 
the three gripper offset ranges overlap, the robot will use the smallest common 
gripper offset to perform a direct labware transfer from device A to device B 
without regripping the labware. If the three ranges do not overlap, the 
software attempts to plan a path through one or more regrip stations. If the 
robot cannot perform the transfer, an error message appears at the time of the 
requested labware transfer.

To provide the system with the greatest flexibility for identifying a grip 
position that works for all locations, you should set the widest possible range 
for each gripper offset parameter.

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Using the Labware Editor “Labware Editor overview” on page 9

Direct Drive Robot Direct Drive Robot User Guide

For information about... See...
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Procedure

To set BenchBot properties:

1 Open the Labware Editor. 

2 In the Labware Entries tab, click the BenchBot sub- tab.

Figure BenchBot sub-tab

3 Enter the values for the following landscape- orientation properties. The 
values must be based on the labware type that you are defining. 
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4 Enter the values for the following portrait- orientation properties. The 
values must be based on the labware type that you are defining. 

Parameter Description

Landscape 
Orientation 
Gripping Ranges 
(mm) 

The distance from the bottom of the microplate to 
the lowest and highest points where the bottom of 
the robot grippers will be holding the microplate in 
landscape orientation. Default range: 0–10 mm

The minimum and maximum values in the ranges 
depend on the given microplate features and the 
robot gripper fingers you are using. For example, 
suppose you are using standard grippers, which 
are 4.5 mm tall. If the microplate has a 6- mm tall 
skirt, you could set the gripper offset range from 
0 mm to 2.00 mm. At the minimum, the standard 
gripper will be flush with the bottom of the 
microplate. At the maximum, the bottom of the 
gripper will be at 2.00 mm, still permitting the 
robot to grip the microplate securely.

Specifying multiple ranges provides the robot with 
additional grip options. In the following example, 
to avoid the ledge at the top of the skirt, you can 
specify two ranges: one above the skirt and 
another on the skirt.

Use a comma to separate ranges.

Landscape Open 
Width

The distance, in millimeters, between the grippers 
when they are open for labware in the landscape 
orientation. Enter a value between 76 and 134 mm.

Landscape Closed 
Width

The approximate distance, in millimeters, between 
the grippers when they are closed. Enter a value 
between 76 and 134 mm.

The Landscape Closed Width value is always used 
with the Landscape Tolerance value. When picking 
up labware, the grippers close until the Grip 
torque is reached. Then, the robot checks to see if 
the distance between the grippers is within the 
Landscape Closed Width value +/-  the Landscape 
Tolerance value. If it is outside the summed value, 
the software will display an error message.

Landscape 
Tolerance

The distance, in millimeters, the Landscape Closed 
Width is allowed to vary without causing an error. 
You can enter a value between 0 and 10 mm.
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Parameter Description

Portrait Orientation 
Gripping Ranges 
(mm)

The distance from the bottom of the microplate to 
the lowest and highest points where the robot 
grippers can hold the microplate in portrait 
orientation. Default range: 0–10 mm

The minimum and maximum values in the ranges 
depend on the given microplate features and the 
robot gripper you are using. The long sides of some 
microplates have a raised section in the middle of 
each side. In this case, set the minimum gripper 
offset higher than the uneven surface to ensure 
that the robot can grip the microplate evenly and 
securely. The following example shows how the 
range can vary depending on the microplate 
features.

Specifying multiple ranges provides the robot with 
additional grip options. In the following example, 
you can specify three ranges: one above the raised 
section, one at the raised section, and one on the 
skirt.

Use a comma to separate ranges.

Portrait Open 
Width

The distance, in millimeters, between the grippers 
when they are open for labware in the portrait 
orientation. Enter a value between 76 and 134 mm.

Portrait Closed 
Width

The approximate distance, in millimeters, between 
the grippers when they are closed. Enter a value 
between 76 and 134 mm.

The Landscape Closed Width value is always used 
with the Landscape Tolerance value. When picking 
up labware, the grippers close until the Grip 
torque is reached. Then, the robot checks to see if 
the distance between the grippers is within the 
Landscape Closed Width value +/-  the Landscape 
Tolerance value. If it is outside the summed value, 
the software will display an error message.

Portrait Tolerance The distance, in millimeters, the Landscape Closed 
Width is allowed to vary without causing an error. 
Enter a value between 0 and 10 mm.

Range

Range
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5 In the Grip torque box, type the percent of maximum grip force the robot 
must use when gripping labware. The range is 0 to 100.

The force with which the robot can grip a labware depends on the labware 
weight, material, and design. You should run some tests to optimize the 
setting.

Related information

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 13

Opening the Labware Editor “Opening the Labware Editor” on 
page 15

Using the Labware Editor “Labware Editor overview” on page 9

Direct Drive Robot Direct Drive Robot User Guide

BenchBot BenchBot Robot User Guide
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3
Specifying pipette speed and accuracy

This chapter contains the following topics:

• “About liquid classes” on page 56

• “Opening the Liquid Library Editor” on page 58

• “Creating a liquid class” on page 59

• “Calibrating the pipettor” on page 62
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About liquid classes

Liquid Library Editor defined

The Liquid Library Editor provides tools for users with technician or 
administrator privileges to enter values for properties that affect pipetting 
speed, accuracy, and precision. 

Figure Liquid Library Editor window

Default liquid library entries

When installing VWorks software, you might have elected to install the default 
liquid library entries. These entries are provided as examples and thus might 
only approximate your particular reagents. For the best performance, you 
should create your own liquid library definitions.

When to use the Liquid Library Editor

You use the Liquid Library to fine- tune the volume aspirated or dispensed by 
your Bravo Platform or Vertical Pipetting Station.

IMPORTANT Verify the pipetting of your Bravo Platform or Vertical Pipetting 
Station. Accurate and precise pipetting depends on a variety of factors 
including the liquid properties. 

Liquid classes defined

The values entered into the Liquid Library Editor can be saved as a collection, 
known as a liquid class. Using liquid classes saves time when writing protocols 
because you do not have to enter values for the liquid properties every time 
you create a protocol.

Types of liquid classes 
You might want to create different classes for different:

• Types of liquids
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For example, water versus DMSO

• Volumes of liquids

For example, 1 µL versus 200 µL

• Liquid operations

For example, washing versus mixing

Liquid library database defined

The data that represents a liquid class is saved to the liquid library database, 
which is maintained in the Windows registry.

Using a liquid class

When preparing for a protocol run, you select the liquid class that you want to 
use. During the run, the liquid class values are referenced for pipetting 
operations.

Calibrating the Bravo Platform and Vertical Pipetting Station

The Liquid Library Editor also has an equation editor that can be used to 
calibrate the Bravo Platform and Vertical Pipetting Station.

Related information

For information about... See...

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 58

Creating a liquid class “Creating a liquid class” on page 59

Calibrating your pipettor “Calibrating the pipettor” on page 62
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Opening the Liquid Library Editor

Before you start

You must be logged in as an administrator or technician to open the Liquid 
Library Editor.

Procedure

To open the Liquid Library Editor from VWorks software:

1 Select Tools > Liquid Library Editor.

The Liquid Library Editor opens.

Related information

For information about... See...

Liquid classes “About liquid classes” on page 56

Creating a liquid class “Creating a liquid class” on page 59

Calibrating your pipettor “Calibrating the pipettor” on page 62
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Creating a liquid class

About this topic

This topic describes how to create a liquid class using the Liquid Library 
Editor.

You must be logged in as an administrator or technician to perform this 
procedure.

Liquid compatibility

Procedure

To create a liquid class:

1 Open the Liquid Library Editor.

2 Click New liquid entry. 

3 In the New Liquid Entry dialog box, type a name for the liquid class and click 
OK.

4 Optional. In the box at the top right of the Liquid Library Editor window, type 
a note describing the entry for your records.

5 On the Aspirate tab, type the values for the following aspirate parameters.

WARNING  Agilent Technologies products are intended to be used with non-hazardous 
liquids. Please contact Automation Solutions Technical Support before using any non-
aqueous solvents or solvents generally considered to be hazardous. 
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Note: The upper limits for some of the parameters might not be 
achievable for the device you are using. 

6 Click the Dispense tab and enter values for the dispense properties.

The following table describes the dispense parameters.

Aspirate Definition

Velocity (µL/s) Specifies the speed of the aspiration stroke.

Acceleration (µL/s2) Specifies acceleration during the aspiration 
stroke.

Post- aspirate delay (ms) Specifies the time the pipettor waits after 
aspiration is complete before moving the 
tips out of the wells.

Z- axis velocity into wells 
(mm/s)

Specifies how fast the pipettor moves as 
the tips enter the wells.

Z- axis acceleration into 
wells (mm/s2)

Specifies the acceleration of the pipettor as 
the tips move into the wells. 

Z- axis velocity out of wells 
(mm/s)

Specifies how fast the tips leave the wells.

Z- axis acceleration out of 
wells (mm/s2)

Specifies the acceleration of the pipettor as 
the tips move out of the wells. 

Dispense Definition

Velocity Specifies the maximum speed 
of the dispensing stroke, in 
microliters per second.

Acceleration Specifies acceleration during 
the dispensing stroke, in 
microliters per second squared.
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7 Click Save changes. 

The changes are now stored in the liquid library database.

Related information

Post- dispense delay Specifies the time the pipettor 
waits after the dispense stroke 
before moving the tips out of 
the wells, in milliseconds.

Z- axis velocity into wells Specifies how fast the pipettor 
moves as the tips enter the 
wells, in millimeters per 
second.

Z- axis acceleration into wells Specifies the acceleration of 
the pipettor as the tips enter 
the wells, in milliliters per 
second squared.

Z- axis velocity out of wells Specifies how fast the pipettor 
moves as the tips leave the 
wells, in millimeters per 
second.

Z- axis acceleration out of wells Specifies the acceleration of 
the pipettor as the tips leave 
the wells, in millimeters per 
second squared.

Dispense Definition

For information about... See...

Liquid classes “About liquid classes” on page 56

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 58

Calibrating your pipettor “Calibrating the pipettor” on page 62
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Calibrating the pipettor

About calibrating the pipettor

You can improve the accuracy of pipetted volumes by:

• Calibrating the pipettor

• Plotting the actual volume dispensed as a function of the set dispense 
volume

• Calculating the polynomial coefficients of the plot

• Entering the coefficients into the liquid library equation editor

Do you need to calibrate your pipettor?

Pipetting accuracy is the ability to dispense an absolute volume of liquid. In 
practice, the volume that is actually dispensed by a pipettor may be different 
from the dispense volume that you select. This difference is the absolute error.

In some protocols, as long as you dispense an excess of liquid, the actual 
volume pipetted is not important. In other protocols, pipetting accuracy can be 
a critical factor. You must remember, though, that every step of an experiment 
has error and there is no point taking time to improve the accuracy of 
pipetting to four significant digits if another step in your protocol has error at 
the third significant digit.

If you are sure that the overall error of the experiment is limited by pipetting 
accuracy, and error at this number of significant figures makes a practical 
difference to you interpretation of the data, consider performing an accuracy 
calibration.

Method overview

This section gives an overview of the method you can use to measure pipetting 
accuracy. It does not give a detailed procedure because that depends on 
exactly how you choose to conduct the experiment.

To calibrate a pipettor, an independent method of measuring dispensed volume 
is required. One method is to dispense a solution of fluorescein dye and 
measure the fluorescence emitted from each microplate well.

IMPORTANT Whichever method you use, verify that the error in the detection 
method is significantly smaller than the pipetting error. Otherwise, the error 
you detect might be from the detection method and not the pipetting error.

The overall method is:

1 Perform a series of pipetting operations in which different volumes are 
pipetted.

2 Measure the volumes of dispensed liquid using the independent measuring 
method.

3 In a spreadsheet program, tabulate the dispense volumes that you set in 
the software against the measured volumes.

4 Plot a graph, with the set dispense volume on the y- axis and measured 
dispense volume on the x- axis.
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The plot will be a curve, reflecting the fact that absolute error is a 
function of the magnitude of the measurement.

5 Use the statistical functions of the spreadsheet program to fit a curve to 
the data.

Your result might look like this:

The dashed line is a reference line, where the set dispense volume equals 
the measured dispense volume. The equation is the polynomial for the line, 
calculated by the spreadsheet program.

6 Enter the curve information into the equation editor of the Liquid Library 
Editor.

If you repeat the experiment, you will find that the curve is much closer to a 
straight line. This is because the equation you entered adjusts the action of the 
servo motor that determines aspirate and dispense volumes, thereby calibrating 
the dispense.

Using the equation editor

You use the equation editor in the Liquid Library Editor to enter the 
calibration curve data and correct for pipetting inaccuracy.

To enter a polynomial into the equation editor:

1 Open the Liquid Library Editor.

2 Click the Equation tab to display the equation editor.

3 In the Highest order of polynomial text box, enter the value for the highest 
order of the polynomial.

This is the largest exponent in the equation and tells you how many terms 
are in the equation. For example, if the highest order of the polynomial is 
3, the equation will have the general form: y = a + bx +cx2 + dx3, where ‘x’ 
is the volume specified by any pipettor task that uses this liquid class. 
With an exponent of three, four rows are added to the equation editor 
table.

4 In the Coefficient/Term table, enter the coefficient and exponent for each 
of the terms in the equation, starting with the zero order term.

y = 9E-05x  + 0.0027x  + 1.0176x - 0.12373 2
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To enter a value, single- click the Coefficient table row twice. Note that the 
exponents are already entered for you and cannot be edited.

The following example is for the curve displayed in the previous graph.

5 Click Save changes.

Related information

For information about... See...

Liquid classes “About liquid classes” on page 56

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 58

Creating a liquid class “Creating a liquid class” on page 59
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4
Tracking and managing labware in 
storage

This chapter contains the following topics:

• “About labware inventory management” on page 66

• “Connecting to the inventory database” on page 69

• “Opening the Inventory Editor” on page 71

• “About inventory groups” on page 73

• “Creating and managing location groups” on page 76

• “Creating and managing plate groups” on page 78

• “Adding labware information in the inventory database” on 
page 81

• “Moving labware between storage devices” on page 91

• “Removing labware information from the inventory database” 
on page 95

• “Using a plate group to process labware” on page 100

• “Creating a plate group with a barcode input file” on page 105

• “Inventory Editor views and filters” on page 108

• “Auditing plate volumes in the Inventory Editor” on page 110

• “Reinventorying the labware inventory” on page 112

• “Exporting and importing the inventory data” on page 114

• “Resolving labware inventory problems” on page 117



4   Tracking and managing labware in storage
About labware inventory management

66 VWorks Automation Control Setup Guide

About labware inventory management

About this topic

This topic provides the background information on how to use the VWorks 
Inventory Editor to track labware moving into and out of storage devices, such 
as the Labware MiniHub.

Barcode tracking versus inventory management

Barcode tracking
Barcode tracking without an inventory system is limited because the labware 
locations are stored in memory and are lost when you exit the VWorks 
software. 

Inventory management
The inventory management system allows long- term tracking of microplates 
because barcode data is permanently stored in a database. This is useful for 
lab automation systems with devices that store microplates for a long time, 
such as the Agilent Labware MiniHub.

Required database

To use inventory management, you must have a MySQL database set up on the 
computer that runs the VWorks software.

How labware is stored

The long- term storage devices supported by the VWorks software store labware 
in cassettes and slots. A cassette is a vertical rack that has many slots, where 
each slot holds one labware.

Information that is stored

The inventory database maintains a list of labware located in long- term 
labware storage devices. Each labware entry in the database includes the 
following information:

• Device in which the labware is located

• Cassette and slot location of the labware

• Names of the location and plate groups to which it belongs

• Labware type

• Any north- side, south- side, east- side, and west- side barcodes

• Volume of the wells in the labware

How to access data in the inventory database 

You use the VWorks Inventory Editor to access the data in the inventory 
database. In the Inventory Editor, you can:
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• View the information in the inventory database.

• Add or import labware information in the database.

• Remove labware information from the database.

• Create or modify plate groups.

• Import plate groups from a barcode file.

• Create or modify location groups.

• Inventory the labware in a storage device.

• Export and import the entire inventory database.

The list of labware in the database is automatically updated every time the 
robot moves a labware into or out of a storage device. If you have a Liconic 
storage device, you can also re- inventory the device to keep the list up- to-
date.

Figure Inventory Editor window

Plate groups and location groups

With long- term storage devices, typically only a subset of the labware stored in 
the device is used in one protocol. You can set up two different types of 
labware subsets, called plate groups and location groups. Which you choose for 
a particular protocol depends on what you are planning to do.

• A plate group consists of a group of labware where the group membership 
is often based on the labware’s unique database identifier.

• A location group is a group of slots in a storage device.

For more information, see “About inventory groups” on page 73.
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Inventory management tasks

The following protocol tasks interact with the inventory database:

• clearInventory

• exportDatabase

• ImportCsvToInventory

• Load

• Unload

• Incubate at microplate storage device

For more information about the tasks, see VWorks Automation Control User 
Guide.

About adding labware into inventory

You can add labware information into the inventory database using one of the 
following methods:

• Run a protocol to physically move labware into the storage device. During 
the run, the system will update the inventory.

• Use the Inventory Editor to:

– Add an individual labware into the inventory.

– Add multiple labware by importing a CSV file.

For detailed instructions, see “Adding labware information in the inventory 
database” on page 81.

Terminology

The following terms are used to describe the movement of labware in the 
system.

Database backup

You can back up the inventory database by exporting it to a SQL file. For 
instructions, see “Exporting and importing the inventory data” on page 114.

Term Definition

Unload The act of moving labware from a storage device into the system.

Load The act of moving labware from the system into a storage device.

System Labware that are being processed by the current protocol are 
considered to be in the system.

For example:

• Labware on a platepad is in the system.

• Labware being incubated in an incubator is in the system.

• Labware half- way up a Stacker rack is not in the system, 
unless it will be moved during the current protocol.

• Labware being stored in a Labware MiniHub is not in the 
system unless it will be moved during the current protocol.
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To back up the inventory database along with the VWorks software system 
files, see VWorks Automation Control User Guide. For assistance, contact 
Automation Solutions Technical Support.

Related information

Connecting to the inventory database

Who should read this

Read this topic if your lab automation system has an incubator or random-
access storage device, such as the Labware MiniHub.

Before you start

Before you can connect to the database, you must install and configure the 
inventory database. To install and set up the inventory database, see the 
appropriate instructions for your Microsoft Windows operating system:

• “Setting up a Windows 7 MySQL database” on page 123 

• “Setting up a Windows 10 MySQL database” on page 133

For assistance, contact Agilent Automation Solutions Technical Support.
                                                        

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 73

Setting up the database “Setting up a Windows 7 MySQL 
database” on page 123

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Incubating labware “Using a plate group to process 
labware” on page 100

Using barcode input files “Creating a plate group with a barcode 
input file” on page 105
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Connecting to the database

The database connection is specified in the VWorks software.

To connect to the database:

1 In the VWorks window, select Tools > Options. The Options dialog box 
appears.

2 Under DB Setup, verify the following, and then click OK.

• Enable database connection is selected.

• Connection string is dsn=velocity11;

Note: velocity11 is the factory- default database name specified in the 
ODBC. If you changed the name in the ODBC, you must update the 
Connection string field in the Options dialog box.

Related information

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 73

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Incubating labware “Using a plate group to process 
labware” on page 100



71

4   Tracking and managing labware in storage
Opening the Inventory Editor

VWorks Automation Control Setup Guide

Opening the Inventory Editor

About this topic

This topic explains the two ways you can open the Inventory Editor:

• “Opening from the Tools menu” on page 71

• “Opening from within a protocol” on page 72

Read this topic if your lab automation system has an incubator or random-
access storage device, such as the Labware MiniHub.

Before you start

Before opening the Inventory Editor, make sure you have installed and 
configured a MySQL database, and connected to the database. For instructions, 
“Connecting to the inventory database” on page 69.

Each labware entry in the inventory database is associated with a storage 
location. To view the contents of the inventory database, you must first open 
the relevant device file and initialize the devices.

Opening from the Tools menu

To open the Inventory Editor from the Tools menu: 
In the VWorks window, select Tools > Inventory Editor.

Using barcode input files “Creating a plate group with a barcode 
input file” on page 105

Specifying the database name in 
the ODBC

“Resolving labware inventory problems” 
on page 117

For information about... See...
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Opening from within a protocol

To open the Inventory Editor from within a protocol:

1 In the protocol, select a Load or Unload task.

2 Click Storage Load in the Task Parameters area.

3 Do one of the following:

• In the Locations tab, click Edit location groups.

• In the Groups tab, click Edit plate groups.
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Related information

About inventory groups

Who should read this

Read this topic if your lab automation system has an incubator or random-
access storage device, such as the Labware MiniHub.

Inventory groups defined

An inventory group is a group of labware or slots that is a subset of the 
labware listed in the inventory. 

Types of inventory groups

There are two types of inventory groups:

• Location group

• Plate group

Location groups

Location groups are used to move labware to and or from a specific location in 
the storage device.

For information about... See...

Connecting to the inventory 
database

“Connecting to the inventory database” 
on page 69

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 73

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Incubating labware “Using a plate group to process 
labware” on page 100

Using barcode input files “Creating a plate group with a barcode 
input file” on page 105
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Example:
In this example, a location group that contains slots 1–10 in cassette 1 is 
created. 

When an Unload task uses this location group, the robot moves whatever 
labware are in cassette 1, slots 1–10, regardless of the identity of the labware, 
out of the storage device and into the system. 

When a Load task uses a location group, it moves the labware that are in the 
system into cassette 1, slots 1–10 of the storage device, regardless of the 
identity of the labware.

When to use
Location groups are used when:

• The storage device is being filled or emptied.

• The groups of labware are removed from the lab automation system and 
replaced with other groups of labware on a regular basis. This would be 
done by replacing a cassette of labware with a new one.

Plate groups

Plate groups are used to move specific labware to or from the storage device, 
but without regard for the location. Plate groups can be used when operators 
do not routinely remove and replace whole cassettes of labware.

When a labware is first moved into the system by the system’s robot, such as 
when it is downstacked, it is assigned an identifier in the database. After that, 
the VWorks software tracks where that labware is at all times. This tracking 
does not require the labware to have barcode labels. The VWorks software 
tracks the movement of each labware through out a protocol.

Note: You cannot use a plate group with a Load task, unless a native location 
or location group is associated with it— you must specify a location. You can 
associate a plate group with the location group so that the labware that are 
loaded are simultaneously loaded into a plate group as well.

Note: When you load into a plate group you must also load into a location 
group, native location, or choose return to original locations, otherwise the 
software will not know where to put the labware.

Example:
A plate group in a storage device contains the following microplates:

• Plate 1

• Plate 26

• Plate 31

• Plate 41

These microplates are scattered around the storage device, not necessarily in 
adjacent slots of the same cassette. When the Unload task uses this plate 
group, it moves these microplates out of the storage device and into the 
system.

When to use
Plate groups are typically used in compound management systems where 
labware are housed in the storage device almost permanently. 

For each protocol, a different plate group is unloaded, run, and then loaded 
back to a storage device. As long as the identification of the labware is 
tracked, the labware can be stored in any open location.
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Group membership

A single labware can be a member of more than one plate group.

Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 76

Creating a plate group “Creating and managing plate groups” 
on page 78

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Incubating labware “Using a plate group to process 
labware” on page 100

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 105

• VWorks Automation Control User 
Guide
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Creating and managing location groups

About this topic

This topic describes how to create a labware location group in the Inventory 
Editor. Read this topic if your lab automation system has an incubator or 
random- access storage device, such as the Labware MiniHub.

Procedure

To create a location group:

1 In the VWorks window, select Tools < Inventory Editor.

2 In the Inventory Editor window, click the Location Groups tab.

3 Click Create new, type a name for the group, and click OK.

4 In the Available Slots area, select a group of slots and drag the selection into 
the Location Members area.

You can use CTRL+click or SHIFT+click to select more than one slot. 
Alternatively, you can double- click a slot to add it to the location group.

Note: The slots do not have to be adjacent to each other. For example, is 
you have different height shelves in the Labware MiniHub, you might 
want the location group to define the same shelf (slots) in all four 
cassettes.
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Note: To delete a member of the location group, select the item in the 
Location Members area, and then press DELETE.

5 Click Save Changes.

6 Close the Inventory Editor window.

The new location group is listed as an available location in Locations tab 
of the Load/Unload Task Parameters area.

Deleting a location group

To delete a location group from the inventory:

1 In the Inventory Editor window, click the Location Groups tab.

2 Select a location group in the Saved Locations area.

3 Click Delete.

Related information

For information about... See...

Creating a plate group “Creating and managing plate groups” 
on page 78

Opening the Inventory Editor “Opening the Inventory Editor” on 
page 71

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Incubating labware “Using a plate group to process 
labware” on page 100

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 105

• VWorks Automation Control User 
Guide
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Creating and managing plate groups

About this topic

This topic describes how to create a plate group, which is a list of specific 
labware that can be moved into or out of a labware storage device without 
regard for which slots they are stored in.

Read this topic if your lab automation system has an incubator or random-
access storage device, such as the Labware MiniHub.

For instructions on how to add labware into the database, see “Adding labware 
information in the inventory database” on page 81.

Procedure

To create a plate group:

1 In the VWorks window, select Tools < Inventory Editor.

2 In the Inventory Editor window, click the Plate Groups tab.

3 Click Create new, type a name for the group, and click OK.

To add labware to the plate group:

1 In the Available Plates area, select a group of available labware, and drag the 
selection into the Group Members area. 

You can use CTRL+click or SHIFT+click to select more than one labware. 
Alternatively, you can double- click a plate to add it to the plate group.

Using storage tasks in a protocol VWorks Automation Control User 
Guide

For information about... See...
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Note: To delete a plate from the plate group, select the plate in the 
Group Members area, and then press DELETE.

2 Click Save Changes.

3 Close the Inventory Editor window.

The plate group is listed as a available groups in the Groups tab in the 
Load/Unload Task Parameters area.

Changing the processing order

You can change the order in which the labware in a plate group will be 
processed.

To change the processing order:

1 In the plate group list, select a labware.
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2 Drag it to another position in the list.

Deleting a plate group

To delete a plate group from the inventory:

1 In the Inventory Editor window, click the Plate Groups tab.

2 In the Saved Groups area, select the plate group.

3 Click Delete.

Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 76

Opening the Inventory Editor “Opening the Inventory Editor” on 
page 71

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Incubating labware “Using a plate group to process 
labware” on page 100

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 105

• VWorks Automation Control User 
Guide

Using storage tasks in a protocol VWorks Automation Control User 
Guide
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Adding labware information in the inventory database

About this topic

You can add labware information in the inventory database in one of many 
ways.

You can also use the plateDB and InventoryLabware JavaScript functions to 
add labware information. For more information, see VWorks Automation 
Control User Guide.

Running a protocol to load labware into a storage device

You can run a protocol to load a batch of labware into storage devices. During 
the run, the system will update the inventory database.

• If the labware has barcode labels and the system has a barcode reader, see 
“Loading labware into storage devices and updating the inventory 
database” on page 81.

• If the labware does not have barcode labels, or if the system does not have 
a barcode reader, see “Updating the inventory database without barcode 
readers” on page 84.

Loading labware into storage devices and updating the inventory database

To run a protocol to load labware into a storage device: 

1 Load the labware in a Labware Stacker by hand before running the 
protocol.

2 Write a protocol that contains the following:

If you want to... See...

• Load a batch of labware into storage 
devices.

• Add the labware information in the 
database.

“Running a protocol to load 
labware into a storage device” 
on page 81

Add the information for a batch of 
labware in the database. 

Note: The labware are already in the 
storage devices.

“Adding multiple labware by 
importing a CSV file” on page 85

• Load a few labware into storage 
devices.

• Add the labware information in the 
database.

“Adding individual labware in 
the inventory database” on 
page 88

Add the information for a few labware in 
the database. 

Note: The labware are already in the 
storage devices.

“Adding individual labware in 
the inventory database” on 
page 88
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– Downstack task to move the labware from the stacker.

– A task that reads the barcode on the labware. 

For example, if the barcode reader is installed on a platepad, add the 
Place Plate task. Make sure the process labware parameter specifies the 
side on which the barcode label resides. The side that you select must 
match the side on which the barcode reader is installed. In addition, 
select Barcode not in file from the Barcode or header list.

If the storage device has an integrated barcode reader, you might not 
need to add this task.

– Load task to move the labware into the storage device.

For instructions on how to write protocols, see “Creating a protocol: basic 
procedure” on page 15.
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3 Make sure that the Downstack task is configured to use the stacker.

4 When adding the Load task, create a location group: 

a Select the Load task.

b Click Storage Load.

c Click the Locations tab.

d Click Edit location groups.

e See “Creating and managing location groups” on page 76 for 
instructions.

f Make sure that the location group is listed in the Available locations 
area of the Load Task Parameters area.

5 Drag the group into the Assigned locations or groups area.
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6 Compile the protocol and resolve any error messages.

7 Run the protocol (click Start).

8 In the Run Configuration dialog box that appears, specify the number of times 
to run the protocol. Type a number that is equal to or less than the 
number of labware you want to load into the storage device.

9 Click Finish. The protocol run starts.

10 To confirm that the labware are in the inventory database, open the 
Inventory Editor. See “Opening the Inventory Editor” on page 71.

Updating the inventory database without barcode readers

If the labware do not have barcode labels, or if the system does not have a barcode 
reader:

1 Load the labware in a Labware Stacker by hand before running the 
protocol.

2 Write the protocol described in “Loading labware into storage devices and 
updating the inventory database” on page 81. You do not need to include 
the barcode- reading task.

3 Add the importCsvToInventory task at the end of the protocol. For more 
information, see VWorks Automation Control User Guide.

4 Compile the protocol and resolve any error messages.

5 Run the protocol (click Start).

6 In the Run Configuration dialog box that appears, specify the number of times 
to run the protocol. Type a number that is equal to or less than the 
number of labware you want to load into the storage device.
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7 Click Finish. The protocol run starts.

8 To confirm that the labware are in the inventory database, open the 
Inventory Editor. See “Opening the Inventory Editor” on page 71.

Adding multiple labware by importing a CSV file

You can add the information for a batch of labware by importing a CSV file in 
the Inventory Editor. Use this method if a large number of labware physically 
exist in the storage device, and you want to enter the labware information in 
the inventory database.

Make sure the CSV file meets the following requirements:

• The accepted delimiters are comma, tab, colon, and semicolon.

• The first row contains the header.

• The columns must consist of the following, in the order shown:

Property Description

DeviceName Required column. The name of the device in which 
the labware resides. 

Make sure the device name in this column matches 
the name in the device file. Be sure to include any 
spaces, underscores, dashes, and capitalization in 
the name.

Cassette Required column. The cassette in which the 
labware resides. 

Make sure the cassette number in this column is 
valid. For example, if the device only has four 
cassettes, the valid values are 1, 2, 3, and 4.

Slot Required column. The slot in which the labware 
resides. 

Make sure the slot number in this column is valid. 
For example, if the cassette only has 5 slots, the 
valid values are 1, 2, 3, 4, and 5.

Type Required column. The type of labware. 

Make sure the labware type in this column 
matches the name in the Labware Editor.

IMPORTANT The labware type may not contain 
any commas.

Name The name of the labware.

WestBC The barcode that is on the west side of the 
labware.

IMPORTANT The west- side barcode must be 
unique, or the labware information will not be 
imported.

EastBC The barcode that is on the east side of the 
labware.

SouthBC The barcode that is on the south side of the 
labware.
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The following example shows that the columns in the file are separated by 
commas. In this example, all required and optional columns are specified in 
the file.

Instead of commas, you can use one of the other delimiters. The following 
example shows the use of tabs instead of commas to separate the columns. In 
this example, only the required columns are included.

To add multiple labware by importing a CSV file:

1 Physically load the cassettes of labware into the storage device.

2 Open the Inventory Editor. See “Opening the Inventory Editor” on page 71.

3 Click the Inventory Management tab.

4 Click Batch add labware.

NorthBC The barcode that is on the north side of the 
labware.

PlateGroup The plate group to which the labware belongs.

LocationGroup The location group to which the labware belongs.

Property Description
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The Batch add labware dialog box opens.

5 Click the browse button to locate and select the CSV file.

6 Select Overwrite all conflicts if an entry already exists in the database and 
you want to replace it with the data in the CSV file. If you do not select 
this option, the software will skip the current labware in the CSV file.

7 Click OK to start importing the labware data.

During the import process:

• The software will import each row of data in the CSV file.

• If one of the required columns is missing, the software will halt the 
import process and display an error message.

• If the storage location is already occupied by a labware:

– The software will overwrite the existing data if you selected 
Overwrite all conflicts, and record the incident in the Main log.

– The software will skip the current row in the CSV file if you 
cleared the Overwrite all conflicts check box.

• If a specified device in the CSV file does not exist in the device file, 
the software will proceed to add the labware information and record 
the error in the log file.

• If the west- side barcode is not unique, the system will skip the current 
row in the CSV file and record the incident in the main log.
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IMPORTANT Make sure you reconcile any conflict before running a 
protocol. Running a protocol with an out- of- date inventory database 
will cause the run to abort.

Adding individual labware in the inventory database

You can add an individual labware entry in the inventory database. Use this 
method if you want to add a nominal number of labware entries in the 
inventory database. For example, instead of running a protocol, you can load 
the labware in the storage device by hand, and then use the Inventory Editor 
to update the inventory database.

To add an individual labware in the inventory database:

1 Open the Inventory Editor. See “Opening the Inventory Editor” on page 71.

2 Click the Inventory Management tab.

3 Click Add labware.

4 In the Add Labware to Inventory dialog box, set the labware properties:
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Property Description

Device name Required field. The name of the device in which 
the labware resides. 

Select the device from the list.

Cassette Required field. The cassette in which the labware 
resides. 

Type the cassette number.

Slot Required field. The slot in which the labware 
resides. 

Type the slot number.

Type Required field. The type of labware. 

Select the labware type from the list.

Note: During a protocol run, the labware type 
specified in the process plate parameters area will 
override the specification in the inventory 
database.

Name The name of the labware.

Type a name that identifies the labware.

South/West/North/
East barcode

The barcode associated with the labware. 

Type or manually scan the barcode to enter it in 
the box. Be sure to enter the barcode in the 
appropriate box to indicate the location of the 
barcode label. For example, if the barcode label is 
on the south side of the labware, enter the 
barcode in the South barcode box.

Plate group The plate group to which the labware belongs.
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5 When you are finished, click OK to save the changes in the database. The 
new labware entry appears in the Inventory View.

6 If you have not done so, make sure you physically load the labware in the 
storage device so that its location matches the information in the database.

Related information

Location group The location group to which the labware belongs.

Property Description

For information about... See...

Moving labware out of a storage 
device

“Removing labware information from 
the inventory database” on page 95

Moving labware between storage 
devices

“Moving labware between storage 
devices” on page 91

The Load and Unload tasks VWorks Automation Control User 
Guide

Exporting the database data “Exporting and importing the inventory 
data” on page 114
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Moving labware between storage devices

About this topic

This topic provides an example to illustrate how you can move a group of 
labware from one storage device to another storage device. The general 
procedure could also be used to move a group of labware within a single 
storage device.

Who should read this

Read this topic if your lab automation system has incubators and random-
access storage devices such as the Labware MiniHub.

Before you start

Make sure that both labware storage devices are properly configured in the 
device manager.

Moving a labware

In this example procedure, a group of four microplates is moved from one 
storage device (Labware MiniHub1) to another (Labware MiniHub2).

To move a labware:

1 Create a process that has a Load and an Unload task, as shown in the 
following example.

2 Select either the Load or Unload task, and in the Task Parameters area, click 
Edit location groups.

The Inventory Editor opens.

3 Click the Inventory Management tab and note the device, cassette, and slot 
locations of the microplates that you want to move.

In this example, the microplates will be moved from MiniHub1, cassette 1, 
slots 1 to 4.

4 Click the Location Groups tab and create a location group for these 
microplates.
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5 In the Inventory Management tab, note the device, cassette, and slot numbers 
for the destination slots. 

In this example, the microplates will be moved to MiniHub2, cassette 2, 
slots 1 to 4.

6 Click the Location Groups tab and create a location group for these slots.

7 Click Save changes and close the Inventory Editor.

8 Select the Unload task, and in the Task Parameters area, drag the location 
group in the first device to the Assigned locations area.
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9 Select the Load task, and in the Protocol Task Parameters area drag the 
location group in the second device to the Assigned locations area.

10 Compile the protocol and check for errors.

11 Click Start to start the run.

12 In the Number of Cycles dialog box, type the number of microplates that you 
are moving and click OK.

13 Open the Inventory Editor, and click the Inventory Management tab to make 
sure that the microplates moved as expected.
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Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 76

Creating a plate group “Creating and managing plate groups” 
on page 78

Opening the Inventory Editor “Opening the Inventory Editor” on 
page 71

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

Incubating labware “Using a plate group to process 
labware” on page 100

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 105

• VWorks Automation Control User 
Guide

Load and Unload tasks VWorks Automation Control User 
Guide
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Removing labware information from the inventory database

About this topic

You can remove labware information from the inventory database in one of 
many ways.

To replace the entire inventory database with known configuration and 
contents, use the inventory management export and import commands. For 
instructions, see “Exporting and importing the inventory data” on page 114.

Running a protocol to unload labware from a storage device 

You can run a protocol to unload a batch of labware from storage devices. 
During the run, the system will automatically track the labware (with or 
without barcodes) and update the inventory database.

To run a protocol to remove labware from a storage device: 

1 Prepare one or more empty Labware Stackers before running the protocol.

2 Write a protocol that contains the following:

– Unload task to remove the labware from the storage device.

– Upstack task to move the labware into an available stacker.

If you want to... See...

• Unload a batch of labware from 
storage devices.

• Remove the labware information from 
the database.

“Running a protocol to unload 
labware from a storage device” 
on page 95

Remove the information for a batch of 
labware from the database. 

Note: The labware have been removed 
from the storage devices previously.

“Removing selected labware 
information from the database” 
on page 98

• Unload a few labware from storage 
devices.

• Remove the labware information from 
the database.

“Removing selected labware 
information from the database” 
on page 98

Remove the information for a few labware 
from the database. 

Note: The labware have been unloaded 
from the storage devices previously.

“Removing selected labware 
information from the database” 
on page 98
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For instructions on how to write protocols, see “Creating a protocol: basic 
procedure” on page 15.

3 Make sure that the Upstack task is configured to use the appropriate 
stacker.

4 In the Inventory Editor, identify the labware that you want to move:

a Click the Unload task.

b Click Storage Load.

c Click the Locations tab.

d Click Edit location groups to open the Inventory Editor.

e Click the Inventory Management tab. Note the device, cassette and slot 
numbers for the labware that you want to remove.
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5 If necessary, create a location group in the Inventory Editor that contains 
the labware you want to remove. See “Creating and managing location 
groups” on page 76 for instructions.

Save the changes and confirm it by making sure it is listed in the Available 
locations area on the Locations tab of the Load Task Parameters toolbar.

6 Drag the location group into the Assigned locations area.

7 Compile the protocol and resolve any error messages.

8 Run the protocol (click Start).

9 In the Run Configuration dialog box that appears, specify the number of times 
to run the protocol. Type a number that is equal to or less than the 
number of labware you want to unload from the storage device.

10 Click Finish. The protocol run starts.

11 To confirm that the labware are removed from the inventory database, 
open the Inventory Editor. See “Opening the Inventory Editor” on page 71.
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Removing selected labware information from the database

You can remove individual labware entries in the inventory database. Use this 
method if you want to remove labware entries under the following scenarios:

• Instead of running a protocol, you can unload individual labware in the 
storage device by hand, and then use the Inventory Editor to update the 
inventory database.

• A batch of labware was already removed from storage devices, but you 
need to remove the corresponding entries from the inventory database.

To remove labware entries from the database:

1 Open the Inventory Editor. See “Opening the Inventory Editor” on page 71.

2 Click the Inventory Management tab.

3 Select the labware entries you want to delete, and then click Delete selected 
entries from inventory.

If you are deleting a batch of labware entries, you can CTRL+click to select 
non- contiguous entries, or SHIFT+click to select contiguous entries.

4 Make sure you physically unload the labware from the storage device so 
that the storage state of the device matches the information in the 
database.

5 Storage devices that have their own barcode readers. To validate the 
changes, in the Inventory Editor Inventory Management tab, click Re-inventory 
selected locations. For instructions, see “Reinventorying the labware 
inventory” on page 112.
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Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 76

Creating a plate group “Creating and managing plate groups” 
on page 78

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Moving labware between storage 
devices” on page 91

Incubating labware “Using a plate group to process 
labware” on page 100

Exporting the database data “Exporting and importing the inventory 
data” on page 114

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 105

• VWorks Automation Control User 
Guide
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Using a plate group to process labware

About this topic

This topic shows an example protocol where a plate group is moved out of a 
Labware MiniHub, transferred to a liquid- handling device where liquid is 
aspirated, and then loaded back into the same or different locations of the 
Labware MiniHub.

Who should read this

Read this topic if your lab automation system has incubators and random-
access storage devices such as the Labware MiniHub.

Before you start

• Place the labware in Labware MiniHub and make sure the labware are 
added to the Inventory Editor.

• Create a plate group containing the labware that you want to process.

To enable the software to track individual plates:

• Under Protocol Options, select the Dynamically assign empty slot to load to storage 
device option. 

Processing a plate group and returning the plates to the original location

To process a plate group:

1 Create a process like the one shown below.

2 Select the Unload task, and in the Task Parameters area, click the Groups tab 
and drag the plate group to the Assigned location area.

3 If you want the labware to be handled in the same numerical order or will 
not be reusing the labware, select Remove plates from group when processed.

Note: The labware can be loaded back into the group during the Load 
task execution.
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4 Select the Load task and then select Use original locations. The Locations and 
Native tabs will become unavailable.

Optional. You can reassign the labware back to the original group or to a 
new plate group. Click the Groups tab and drag the plate group from the 
Available groups area to the Assigned locations area. 
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5 Click Start.

6 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of labware that you want to process from the group.

7 Click OK.

8 To confirm that the labware have been returned to their original position 
in the inventory:

a Click the Load task.

b Click Edit location groups or Edit plate groups.

c Click the Inventory Management tab.

Processing a plate group and returning the labware to a different location

To process a plate group:

1 Create a protocol like the one shown below.

2 Select the Unload task. In the Task Parameters area, click the Groups tab and 
drag the plate group to the Assigned locations or groups area.



103

4   Tracking and managing labware in storage
Using a plate group to process labware

VWorks Automation Control Setup Guide

3 Select the Load task. In the Task Parameters area, choose one of the following 
ways to load the labware into a different location.

• Specify a predefined location group to load to. To specify a predefined 
location group, click the Locations tab and drag the location group to 
the Assigned locations or groups area.

• Assign specific locations to load to without using a location group, as 
follows:

Click the Native tab, and drag the selected locations to the Assigned 
locations or groups area.
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4 Click Start.

5 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of labware that you want to process from the group.

6 Click OK.

7 To confirm that the labware have been returned to their assigned positions 
in the inventory:

a Click the Load task.

b Click Edit location groups or Edit plate groups.

c Click the Inventory Management tab.

Related information

For information about... See...

Software inventory “About labware inventory management” 
on page 66

Creating a plate group “Creating and managing plate groups” 
on page 78

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 105

• VWorks Automation Control User 
Guide
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Creating a plate group with a barcode input file

About this topic

This topic describes how to use a barcode input file to create a plate group. 
This is the most efficient way to create a plate group if you previously used a 
barcode input file to label a collection of labware that are now stored in a 
storage device.

Who should read this

Read this topic if your lab automation system has incubators and random-
access storage devices such as the Labware MiniHub.

Barcode input files

The barcode input file must be a text file, created in Notepad or equivalent 
editor, and have the .csv or .bar file name extension. The input file can be 
stored anywhere on the computer that runs the VWorks software.

File requirements for .csv files
• The file may contain any number of columns, but only the first 5 columns 

are significant. 

• The first column file indicates the barcode group name. 

• The second, third, fourth, and fifth columns indicate the north, south, west, 
and east barcode, respectively.

In the following example, Set1 and Set2 are the group names. Plates A0001 
through A0005 in the Set1 group, and plates B0001 to B0004 are in the 
Set2 group. All barcodes are on the west side in this example.

Starting a run VWorks Automation Control User 
Guide

Load and Unload tasks VWorks Automation Control User 
Guide

For information about... See...
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File requirements for .bar files
• The file must contain only one column. The column can contain as many 

groups of plates as desired.

• The first row in each plate group must contain the string, <name>, 
followed by the group name.

In the following example, Set1 and Set2 are the group names. All barcodes 
are on the west side of the plate. Plates A0001 through A0005 are in the 
Set1 group.

Procedure

IMPORTANT All labware with barcodes listed in the selected barcode input 
file series must already be in the storage device. To load labware into storage 
devices, see “Adding labware information in the inventory database” on 
page 81.

To create a plate group with a barcode input file:

1 In the Inventory Editor window, click the Groups tab.

2 In the Bar Code File Input area, click the Browse button and locate the .bar or 
.csv file that you want to use.
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3 From the Available bar code groups list, select the group that you want to use. 
If you do not see the desired group name, check the input file. See 
“Barcode input files” on page 105.

If you are using the input file in the following example, you should see 
Set1 and Set2 in the Available bar code groups list.

4 In the Available bar code sides list, select which of the plate’s four barcodes is 
going to be matched with a barcode read from the imported file. 

If the imported file is a .csv file, this list also specifies which column in 
the .csv file to use when matching the existing plate’s barcode:

• northbc means match to column 2

• southbc means match to column 3

• westbc means match to column 4

• eastbc means match to column 5

The software ignores the other three barcode columns in the .csv file.

5 Click Import.

The labware labeled with the barcodes listed in the series will be used to 
create a plate group.

6 In the Inventory Management tab, specify a labware type for each labware.

Related information

For information about... See...

Software inventory “About labware inventory management” 
on page 66

Opening the Inventory Editor “Opening the Inventory Editor” on 
page 71

Using the labware selection list “Reinventorying the labware inventory” 
on page 112
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Inventory Editor views and filters

About this topic

This topic describes how to make the Inventory Editor easier to work with by 
showing only the items in the Inventory Editor that are relevant at the 
particular time.

Who should read this

Read this topic if your lab automation system has incubators and random-
access storage devices such as the Labware MiniHub.

Inventory Editor views

There are three ways to view the labware in the Inventory Editor.

To set the view:

1 In the Inventory Editor window, click the Inventory Management tab.

2 In the Select view type list, select one of the following options:

Filtering displayed labware

To simplify your view of the database, you can filter the records that are 
displayed.

To filter the labware records:

1 Right- click a list in any of the tabbed pages of the Inventory Editor and 
select Show all.

2 Right- click a particular cell and select from the available filtering options.

View Description

View by plate Displays every labware in the inventory. 

This is the most frequently used view.

View by location Displays both labware and slots.

View unassigned 
plates

Displays labware that were orphaned during 
previous runs, or the labware that are in the 
system but not in a storage device.

View Description

Use last filter Returns the display of items to that displayed 
when the last filter was applied

Filter by row The items that have the same value as the selected 
item in the row are displayed

Filter by column The items that have the same value as the selected 
item in the column are displayed
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The items that have the same value as the selected item in the row are 
displayed.

The result is that only those plates in cassette number 2 are listed.

To show all labware records:

Right- click on the database list and select Show all.

Related information

For information about... See...

Software inventory “About labware inventory management” 
on page 66

Opening the Inventory Editor “Opening the Inventory Editor” on 
page 71
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Auditing plate volumes in the Inventory Editor

About this topic

The VWorks software tracks the pipetting tasks performed on the labware 
during a protocol run, calculating the volume resulting from those tasks, and 
storing the information in the database. When the labware is displayed in the 
software, the volume is represented with color.

This topic describes how to use the Inventory Editor to audit the volume in a 
labware.

Procedure

To audit the volume of a labware:

1 In the Inventory Editor window, click the Inventory Management tab.

2 From the Select view type list, select the view.

3 Select the labware you want to audit.

4 Click Visualize Plate. The Audit Plate dialog box opens.
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The liquid volume is displayed on the right. You can change the limits of 
this scale in the Scaling area. 

The color legend indicates the following conditions.

Click this button... To...

Zero based plate limits Set the gradient limits from 0 µL 
to the highest volume found in the 
labware.

Auto scale to plate limits Set the scale limits to the lowest 
and highest volume found in the 
labware.

Fixed Scales 1- 7 µL Set the minimum and maximum 
limits to 1 µL and 7 µL, 
respectively.

Manual limits (thresholds) Manually set the lower and upper 
limits. Enter the value (in µL) in 
the Min and Max boxes.

Condition Description

Not surveyed The well is not available for 
measurement.

Empty The well is empty.
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Double- click on a color in the legend to change it.

Related information

Reinventorying the labware inventory

About this topic

This topic describes how to use the reinventory feature of labware inventory.

This feature can be used to check for mismatches by comparing the identities 
of the labware actually in a storage device to the labware that the inventory 
database says should be in the storage device. 

The reinventory feature can also be used to enter barcode information for 
labware that have been manually placed into the storage device.

Note: Reinventorying requires that the storage device has a barcode reader.

Who should read this

Read this topic if your lab automation system has a storage device that 
includes an optional barcode reader.

About performing an inventory

The accuracy of the inventory database can be checked by performing a new 
inventory of the database. You can perform an inventory of the entire storage 
device or part of it.

The device’s barcode reader checks all selected slots for the presence of a 
barcode and reads those that it finds. The results are checked against the 
inventory database.

IMPORTANT For reinventorying to be successful, each labware must have a 
unique barcode.

Below threshold The well is below the lower limit set 
by the user.

Above threshold The well is above the upper limit set 
by the user.

Condition Description

For information about... See...

Software inventory “About labware inventory management” 
on page 66

Opening the Inventory Editor “Opening the Inventory Editor” on 
page 71
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Reinventorying logic

If a labware is found in a slot that, according to the inventory database, 
should be empty, a line is added to the Inventory Editor for that slot and the 
labware barcode is recorded. If that barcode is already associated with another 
slot in the database, the previous association is deleted. In doing this, the 
system assumes that the labware has been manually moved.

If the inventory has a line for a labware in a particular slot, but the inventory 
finds no labware in that slot, the line is removed from the inventory. However, 
the data in the system that is associated with the labware is not deleted. If in 
the future, a labware with an identical barcode is returned to the system, 
when the next inventory is performed the data can be reassociated with it.

Procedure

To reinventory the storage device:

1 In the Inventory Editor window, click the Inventory Management tab.

2 From the Select view type list box, select View by location.

This lists the labware in the inventory database by location.

3 Select the labware that you want to inventory.

You can use SHIFT+click to select a range of listed labware.

4 Under Inventory Management Functions, type the Name of the location 
group.

5 In the Labware list, select the type of labware.

6 Select one of the following options.
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7 Click Reinventory selected locations.

A barcode reader reads each labware in the storage device and adds the 
barcode data to the inventory database.

Related information

Exporting and importing the inventory data

About this topic

You can export the inventory data to create a backup copy of the inventory 
database without performing a system- wide backup. You can also use the 
backup copy to restore the inventory data in case they become damaged or 
lost.

This topic describes how to use the following methods to back up and recover 
the inventory data:

• “Exporting the inventory data” on page 115

• “Importing the inventory data” on page 115

Option Comments

Replace any inventoried labware 
with the labware selected above

Labware for all selected items are 
replaced with the labware displayed 
in the list box. This overwrites 
labware already assigned.

Replace inventoried labware 
with the labware selected above 
ONLY if a labware is not already 
assigned

Labware for all selected items that do 
not already have a labware entry are 
replaced with the indicated labware.

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 73

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Changing the labware associated 
with labware record in the 
inventory database

“Reinventorying the labware inventory” 
on page 112

Inventory Editor filters “Inventory Editor views and filters” on 
page 108
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To back up all VWorks software system files, see VWorks Automation Control 
User Guide.

Exporting the inventory data

You can export the inventory data for backup and recovery.

To export the inventory data:

1 Open the Inventory Editor. See “Opening the Inventory Editor” on page 71.

2 Click the Inventory Management tab.

3 Make sure the inventory data is up- to- date. See “Reinventorying the 
labware inventory” on page 112.

4 Click Export inventory.

The Export Inventory dialog box opens.

5 Click the browse button to select the folder in which you want to store the 
backup copy.

6 Click OK. The software exports the inventory data. The exported file has a 
.sql file name extension.

Importing the inventory data

You can import the inventory data as part of the data recovery process.



4   Tracking and managing labware in storage
Exporting and importing the inventory data

116 VWorks Automation Control Setup Guide

To import the inventory data:

1 Open the Inventory Editor. See “Opening the Inventory Editor” on page 71.

2 In the Inventory Management tab, click Import inventory.

The Import Inventory dialog box opens.

3 Click the browse button to locate and select the backup file.

4 Click OK. The software imports the inventory data.

Related information

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 73

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91
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Resolving labware inventory problems

About this topic

This topic describes how to check and test the Windows Open Database 
connection that is used by the VWorks software inventory management system. 

Checking the database settings

The inventory database uses a Windows Open Database Connectivity (ODBC) 
interface. If you encounter inventory management problems, you may need to 
check the database settings.

To check the database settings:

1 Open the ODBC Data Source Administrator as follows:

a In the Windows Explorer, navigate to C:\Windows\SysWOW64.

b Right- click odbcad32.exe and select Run as administrator.

2 Click the System DSN tab.

Changing the labware associated 
with labware record in the 
inventory database

“Reinventorying the labware inventory” 
on page 112

Inventory Editor filters “Inventory Editor views and filters” on 
page 108

For information about... See...
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3 Click Configure.

The Connector/ODBC dialog box opens showing the database settings.

The Data Source Name and Database parameters must both specify 
velocity11.

Testing the connection

To test the database connection:

1 Follow the procedure in “Checking the database settings” on page 117 to 
open the Connector/ODBC dialog box.

2 Click Test.

A message appears and confirms a successful connection.

Related information

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 73

Moving labware in and out of a 
storage device

• “Adding labware information in the 
inventory database” on page 81

• “Removing labware information 
from the inventory database” on 
page 95

• “Moving labware between storage 
devices” on page 91

Changing the labware associated 
with plates in the inventory 
database

“Reinventorying the labware inventory” 
on page 112
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5
Planning and managing user accounts

This chapter contains the following topics:

• “Planning user accounts and privileges” on page 120

• “Managing user accounts” on page 121

For a description of how to set up user accounts that can be 
shared across multiple computers, see the VWorks Bravo Platform 
for Windows Non- Administrators Setup Guide. This guide 
describes how to configure the VWorks Automation Control 
software so that Windows users with non- Administrator privileges 
can use the VWorks software to operate the Bravo Automated 
Liquid Handling Platform.

For instructions on how to set up email for error notification, see 
the VWorks Automation Control User Guide.
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Planning user accounts and privileges

The role of user accounts

You must have a user account to log in to VWorks software. Your user account 
is associated with a user role that determines the privileges you have to 
perform particular functions. Users are added and assigned privileges by an 
Administrator.

The effect of privileges

Privileges have the following effects:

• If you do not have the privilege to perform a function associated with a 
particular menu command, the text of the command is gray.

• If you do not have the privilege to perform the functions accessed from a 
particular tabbed page, the tab is not visible to you.

• In some cases, if you do not have the privilege to perform an operation, 
when you attempt the operation you get an error message telling you that 
your privileges are insufficient.

User roles and privileges

User roles enforce the following privileges:

 

User role Has privileges to...

Guest • Log in and log out.

• Access the Knowledge Base through the Help 
menu.

• Use context- sensitive help.

Operator • Perform guest functions (see above).

• Operate devices in real- time using diagnostics 
software.

• Run protocols.

Technician • Perform operator functions (see above).

• Create and save protocols.

• Manage devices through the device manager.

• Perform all of the functions listed in the Tools 
menu (except managing users).

Administrator • Perform technician functions (see above).

• Manage user accounts.

• Run a protocol that contains compiler errors.



121

5   Planning and managing user accounts
Managing user accounts

VWorks Automation Control Setup Guide

Related information

Managing user accounts

About user accounts and passwords

User accounts and passwords use the following conventions:

• User accounts can be disabled but not deleted.

• User names and passwords are case- sensitive.

• Passwords must contain six or more characters.

• If a user enters an incorrect password five times consecutively, the user is 
locked out until an administrator resets the account.

Adding a user account

To add a user account:

1 Select Tools > User Management.

2 In the User Management dialog box, click Create new user and enter a name 
for the user.

3 In the Set Password dialog box, enter the password twice for the new user.

4 Enter values in the User information, and User security areas.

5 Click Update selected user to save changes, and then close the dialog box.

For information about... See...

Managing user accounts “Managing user accounts” on page 121

Setting up email notification VWorks Automation Control User 
Guide
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Disabling a user account

You cannot delete a user account, but you can disable it.

To disable an account so that the user cannot log in:

1 Select Tools > User Management.

2 Select the account.

3 Select the Account disabled check box.

4 Click Update selected user to save changes, and then close the dialog box.

Resetting a user account

If a user mistypes the password five consecutive times, the user is locked out 
of the account until an administrator resets the account.

To reset an account:

1 Select Tools > User Management.

2 Select the account.

3 Click Reset failed login count.

4 Click Update selected user to save changes, and then close the dialog box.

Changing a password

An administrator can reset the password of any account. Technicians can 
change their own passwords at Log in.

To reset a password:

1 Select Tools > User Management.

2 Select the account.

3 Click Set password, enter the new password twice and click OK.

4 Click OK to the Password Update message.

Related information

For information about... See...

User accounts “Planning user accounts and privileges” 
on page 120

Setting up email notification VWorks Automation Control User 
Guide
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Setting up a Windows 7 MySQL 
database 

The VWorks labware inventory management feature requires a 
MySQL database. This section describes how to install and 
configure a MySQL 5.1 database for the Microsoft Windows 7 64- bit 
operating system. 

Note: The database may be configured already if the computer was 
provided by Agilent Technologies and your system contains a 
device that requires a database, such as a Labware MiniHub.

The topics are:

• “Installing and setting up MySQL 5.1” on page 124

• “About uninstalling MySQL” on page 131

If you are running the VWorks software on the Microsoft Windows 
10 operating system, see “Setting up a Windows 10 MySQL 
database” on page 133.
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Installing and setting up MySQL 5.1

Before you start

Required installation files
Ensure you have the following installation files:

• mysql- essential- 5.1.44- winx64.msi

• mysql- connector- odbc- 5.1.6- winx64.msi

• velocity11_mysql5.sql 

This file is installed with the VWorks software in 
C:\Program Files (x86)\ 
Agilent Technologies\VWorks\Schema\velocity11_mysql5.sql

For assistance, contact Agilent Technologies Automation Solutions Technical 
Support. 

Required computer settings
Before you install the MySQL software:

• Log on to the computer as an administrator with full rights.

• In Microsoft Windows Explorer, configure the following settings:

Folder options > View settings:

– Select Show hidden files, folders, and drives.

– Clear the Hide extensions for known file types check box.

For detailed instructions, see the Microsoft Windows user documentation.

Installation and setup workflow

Installing MySQL Server 5.1

To install MySQL Server 5.1:

1 Double- click the installation file: 

mysql- essential- 5.1.44- winx64.msi

2 When the MySQL Server 5.1 Setup Wizard opens:

a Click Next to start the wizard.

Step For this task... See...

1 Uninstall any existing MySQL 
versions and restart the 
computer.

“About uninstalling MySQL” on 
page 131

2 Install MySQL Server 5.1. “Installing MySQL Server 5.1” on 
page 124

3 Install MySQL ODBC and 
import the database.

“Installing and setting up a MySQL 
ODBC” on page 127

4 Connect to the VWorks 
inventory management 
database.

“Connecting to the inventory 
database” on page 69
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b In the Setup Type page, select Typical > Next. 

c Click Install.

d In the Wizard Completed page, select Configure the MySQL Server now > Finish.

3 When the MySQL Server Instance Configuration Wizard opens:

a Click Next to start the wizard.

b Select Standard Configuration > Next. 

4 In the select Windows options page, select all 3 check boxes, and then click 
Next:

• Install as Windows Service

• Launch MySQL Server automatically

• Include Bin Directory in Windows PATH
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5 In the security options page, do the following:

a Select Modify Security Settings

b Enter the New root password as velocity11

c Select Enable root access from remote machines

d Select Create An Anonymous Account > Next.

6 When the Ready to execute page appears, click Execute.

7 When the configuration file has been successfully created and the security 
settings have been applied, click Finish.
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Installing and setting up a MySQL ODBC 

To install and set up a MySQL ODBC connection:

1 Double- click the installation file: 

mysql- connector- odbc- 5.1.6- winx64.msi

2 When the MySQL Connector/ODBC 5.1 Setup Wizard opens:

a Click Next to start the wizard.

b In the Setup Type page, select Typical > Next. 

c Click Install to start the installation.

d In the Wizard Completed page, click Finish. 

3 Copy the velocity11_mysql5.sql file into the following folder:

C:\Program Files\MySQL\MySQL Server 5.1\bin\
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4 From the Windows desktop, open a command window as follows:

a In Windows Explorer, navigate to C:\Windows\System32.

b Right- click cmd.exe and select Run as administrator.

c In the User Account Control dialog box, click Yes.

5 Execute the following lines in the command window to copy the provided 
velocity11 database file into the MySQL Server program:

cd c:\ <press ENTER>

cd Program <press TAB> 

cd MySQL <press ENTER>

cd MySQL <press TAB> 

cd bin <press ENTER>

mysql < velocity11_mysql5.sql <press ENTER>

Close the command window.

6 Open the ODBC Data Source Administrator to create an ODBC connection, 
as follows: 

a In Windows Explorer, navigate to C:\Windows\SysWOW64.

b Right- click odbcad32.exe, and select Run as administrator.

7 In the ODBC Data Source Administrator dialog box:
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a Remove any previously defined MySQL ODBC Driver Sources as follows:

• Click the User DSN tab, select any predefined MySQL ODBC 
Driver Sources named velocity11, and click Remove. 

• Click the System DSN tab, select any predefined MySQL ODBC 
Driver Sources named velocity11, and click Remove.

b In the System DSN tab, click Add to create a new data source.

c In the Create New Data Source dialog box, select MySQL ODBC 5.1 Driver, and 
then click Finish.

8 In the MySQL Connector/ODBC Data Source Configuration dialog box that opens, 
define your data source as follows:

Note: Use the default port number displayed in the Port box.

Connection Parameters Settings

Data Source Name velocity11



A   
Installing and setting up MySQL 5.1

130 VWorks Automation Control Setup Guide

9 Click Details to expand the dialog box. In the Flags 1 tab, select the 
following:

• Return Matching Rows

• Enable Auto Reconnect

10 To verify that the data source file is properly configured, click Test. A 
message appears telling you that the connection was successful. Click OK to 
return to the ODBC Data Source Administrator dialog box.

                                                        

Description v11 database (optional)

Server localhost

User root

Password velocity11

Database velocity11

Connection Parameters Settings
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11 In the System DSN tab, verify that velocity11 appears in the System Data 
Source box, and then click OK.

Related information

About uninstalling MySQL

About this topic

This topic provides the workflow for uninstalling MySQL. 

Workflow

The workflow to uninstall previous MySQL installations is as follows. 

1 If applicable, export the existing MySQL velocity11 database to an SQL file 
and move the file to a backup storage location. For instructions, see 
“Exporting and importing the inventory data” on page 114.

For information about... See...

VWorks labware inventory 
management feature

“About labware inventory management” 
on page 66

How to connect to the VWorks 
inventory management database

“Connecting to the inventory database” 
on page 69

CAUTION Incorrectly modifying the registry can result in serious software problems. 
Contact Agilent Automation Solutions Technical Support for assistance with the following 
workflow.
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2 Use the Windows Add/Remove programs feature to uninstall MySQL Server 
and MySQL Connector/ODBC.

3 Restart the computer.

4 Verify that MySQL service is completely removed from the computer’s list 
of services. To display the services, go to  
MyComputer > Manage Computer > Services and Applications > Services

If MySQL appears in the list, do the following:

a Right- click MySQL, and select Stop. An unable- to- stop error message 
may appear.

b Open a Command Prompt window:

• In the C:\Windows\System32. folder, right- click cmd.exe, and then 
select Run as administrator.

• In the User Account Control dialog box, click Yes.

c Execute the following lines in the Command Prompt window:

sc delete MySQL <ENTER>

5 Check the Microsoft Windows registry keys for any references to old 
versions of MySQL.

In the Registry Editor, navigate to 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\MySQL AB\

If present, delete MySQL Server 5.1 or MySQL Server 5.0.

6 Restart the computer.

Related information

For information about... See...

Installing MySQL 5.7 for Microsoft 
Windows 10 operating system

“Setting up a Windows 10 MySQL 
database” on page 1

Installing MySQL 5.1 for Microsoft 
Windows 7 operating system

“Installing and setting up MySQL 5.1” 
on page 124
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Setting up a Windows 10 MySQL 
database 

The VWorks labware inventory management feature requires a 
MySQL database. This section describes how to install and 
configure a MySQL 5.7 database if you are running the VWorks 
software on the Microsoft Windows 10 64- bit operating system.

Note: The database may be configured already if the computer was 
provided by Agilent Technologies and your system contains a 
device that requires a database, such as a Labware MiniHub.

If you are running the VWorks software on the Microsoft 
Windows 7 operating system, see “Setting up a Windows 7 MySQL 
database” on page 123.
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Before you start

Required installation files
To install MySQL 5.7, ensure you have the following installation files:

• vc2013redist_x86.exe

• mysql- installer- community- 5.7.13.0.msi

• velocity11_mysql57.sql

This file is installed with the VWorks software in 
C:\Program Files (x86)\ 
Agilent Technologies\VWorks\Schema\velocity11_mysql57.sql.

For assistance, contact Agilent Technologies Automation Solutions Technical 
Support. 

Required computer settings
Before you install the software:

• Log on to the computer as an administrator with full rights.

• In Microsoft Windows Explorer, configure the following settings:

Folder options > View settings:

– Select Show hidden files, folders, and drives.

– Clear the Hide extensions for known file types check box.

For detailed instructions, see the Microsoft Windows user documentation.

Installation and setup workflow

Installing MySQL 5.7

To install Microsoft Visual C++ 2013 redistributable package:

1 Double- click the vc2013redist_x86.exe file.

2 Follow the Setup Wizard instructions.

To install MySQL 5.7:

1 Double- click the installation file:

mysql- installer- community- 5.7.13.0.msi

2 When the MySQL Installer setup wizard opens, accept the license terms and 
click Next.

Step For this task... See...

1 Uninstall any existing MySQL 
versions, and then restart the 
computer.

“About uninstalling MySQL” on 
page 131

2 Install MySQL Server 5.7. “Installing MySQL 5.7” on page 134

3 Install MySQL ODBC and 
import the database.

“Installing and setting up a MySQL 
ODBC” on page 141

4 Connect to the VWorks 
inventory management 
database.

“Connecting to the inventory 
database” on page 69
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3 In the Choose a Setup Type page, select Custom, and then click Next.
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4 In the Select Products and Features page:

a Under Available Products, select the MySQL Server 5.7.13 - X64 and 
Connector/ODBC 5.3.6 - X86 products.

b Click the right arrow to move the selections to the Products/Features 
To Be Installed area, as the following figure shows.

c Click Next.

5 In the Installation page: 

a Ensure that ODBC 5.3.6 and MySQL Server 5.7.13 are ready to install, 
and then click Execute.

b When the installation is finished, click Next.
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6 In the Product Configuration page, click Next.

7 In the Type and Networking page, specify the following:

• In the Config Type list, select Development Machine.

• Select the TCIP/IP and Open Firewall port for network access check boxes.

• Select the Show Advanced Options check box.

Click Next.
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8 In the Accounts and Roles page, type velocity11 for MySQL Root Password 
and Repeat Password fields. 

Click Next.

9 In the Windows Service page, do the following:

• Select the Configure MySQL Service as a Windows Service check box. 

• In the Windows Service Name box, type MySQL.

• Select the Start the MySQL Server at Startup check box.

• Select the Standard System Account option.

Click Next.
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10 In the Plugins and Extensions page, keep the default settings. Click Next.

11 In the Advanced Options page, keep the default settings. Click Next.
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12 In the Apply Server Configuration page, click Execute to apply the configuration 
settings.

13 Click Next to finish the configuration.
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14 Click Finish to close the installer.

Installing and setting up a MySQL ODBC 

During the MySQL ODBC connection setup you will:

• Import the VWorks inventory (velocity11) database into MySQL. This sets 
up the database table structures for use by the VWorks Inventory Editor.

• Create, define, and configure a new ODBC data source so that MySQL can 
access data in the VWorks inventory (velocity11) database.

To import the database structure:

1 Copy the velocity11_mysql57.sql file into the following folder:

C:\Program Files\MySQL\MySQL Server 5.7\bin\

2 Open the Command Prompt window, as follows:

a In the C:\Windows\System32 folder, right- click cmd.exe, and then select 
Run as administrator.

b In the User Account Control dialog box, click Yes.

3 Execute the following lines in the Command Prompt window:

cd c:\program files\mysql\mysql server 5.7\bin <ENTER>

mysql -u root -p < velocity11_mysql57.sql <ENTER>

When prompted for a password, enter velocity11.
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To create an ODBC connection:

1 Open the ODBC Data Source Administrator to create an ODBC connection, 
as follows: 

a Navigate to C:\Windows\SysWOW64.

b Right- click odbcad32.exe, and select Run as administrator.

2 In the ODBC Data Source Administrator dialog box:

a Remove any previously defined MySQL ODBC Driver Sources as follows:

• Click the User DSN tab, select any predefined MySQL ODBC 
Driver Sources named velocity11, and click Remove. 

• Click the System DSN tab, select any predefined MySQL ODBC 
Driver Sources named velocity11, and click Remove.

b In the System DSN tab, click Add to create a new data source.

c In the Create New Data Source dialog box, select MySQL ODBC 5.3 ANSI 
Driver, and then click Finish.

3 In the MySQL Connector/ODBC Data Source Configuration dialog box that opens, 
define your data source as follows:

Note: You do not have to provide a port number. Use the default number 
displayed.

a Specify the following parameter settings.

Connection Parameters Settings

Data Source Name velocity11

Description v11 database (optional)

Server localhost

User root

Password velocity11

Database velocity11
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b Click Details to expand the dialog box.

c In the Connection tab, select the Enable automatic reconnect check box.

d In the Cursors/Results tab, select the Return matched rows instead of affected 
rows check box.

4 Click Test. A Success, Connection was made message appears. Click OK.

Related information

For information about... See...

VWorks labware inventory 
management feature

“About labware inventory management” 
on page 66

How to connect to the VWorks 
inventory management database

“Connecting to the inventory database” 
on page 69
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Index
A
acceleration property, 60
administrator privilege, 120

B
barcode

input file, 106
inventory manager, 66
tracking, 66

C
can be mounted property, 26
can be sealed? property, 24
can have lid? property, 24
can mount property, 25
cassette, defined, 66
check orientation property, 46
column-wise teachpoint to well property, 29
column-wise well to well property, 29
context-sensitive help, ix

D
database

backup, 68
connection, 69, 71
inventory management, 66
reinventorying, 113
reinventorying, connection checking, 117
setting up, 69, 71
SQL, 66, 123, 133
synchronizing, 68

disposable tip capacity property, 29
disposable tip length property, 29

E
errors

reporting, 5, 6

G
general properties for labware, defining, 20
guest privilege, 120

H
hardware

errors, 5

I
image, inserting labware, 36
Incubate at Storage Device task, 68
inventory editor, 66

filtering displayed records, 108

opening, 71
setting view, 108

inventory group, defined, 73
inventory management, database, 66
inventory manager, 66

database connection, checking, 117
filters, 108
overview, 66
views, 108

inventory, synchronizing, 68
inventory. see also reinventory

J
job roles for readers of this guide, vi

K
knowledge base, viii

L
labware

adding, 18
classes page, 30
defining classes, 30
defining general properties, 20
defining pipette/well properties, 28
defining plate properties, 22
defining stacker properties, 44
inserting an image, 36
moving between storage devices

Labware Editor
classes page, 12
entries page, 10
opening, 15

length of filter tip/pin tool property, 26
lid properties, 25
lidded stacking thickness property, 24
lidded thickness property, 24
liquid library

adding an entry, 59
calibrating the pipettor, 57
classes defined, 56
database defined, 57
editor defined, 56
opening the editor, 58

Liquid Library Editor
about, 56
opening, 58

Load task, 68, 71
location group, 67

creating, 76
defined, 73
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Index

deleting, 77
logging in, 3
lower plate at Microplate Labeler property, 25

M
maximum robot handling speed property, 26
MySQL database, 123, 133

N
notch locations property, 46

O
online help, viii
operator privilege, 120
orientation sensor offset property, 45
orientation sensor threshold (max) property, 45
orientation sensor threshold (min) property, 45

P
passwords, 121
PDF guide, viii
pipette/well, defining labware properties, 28
plate group, 67

changing processing order, 79
creating, 78
creating with barcode input file, 106
defined, 74
deleting, 80
processing plates using, 100, 102

plate group editor, 66
plate inventory. see reinventory
plate properties, defining, 22
plates. see  labware
post-aspirate delay property, 60
post-dispense delay property, 61
presentation offset property, 45
privileges, user, 120
property

acceleration, 60
can be mounted, 26
can be sealed?, 24
can have lid?, 24
can mount, 25
check orientation, 46
column-wise teachpoint to well, 29
column-wise well to well, 29
disposable tip capacity, 29
disposable tip length, 29
length of filter tip/pin tool, 26
lidded stacking thickness, 24
lidded thickness, 24
lower plate at Microplate Labeler, 25
maximum robot handling speed, 26
notch locations, 46

orientation sensor offset, 45
orientation sensor threshold, 45
post-aspirate delay, 60
post-dispense delay, 61
presentation offset, 45
row-wise teachpoint to well, 29
row-wise well to well, 29
sealed stacking thickness, 24
sealed thickness, 24
sensor intensity, 45
stacker gripper offset, 45
stacking thickness, 24
thickness, 23
use vacuum clamps, 46
velocity, 60
well depth, 28
well diameter, 28
well geometry, 28
well volume, 28
well-bottom shape, 29
z-axis acceleration into wells, 60, 61
z-axis acceleration out of wells, 60, 61
z-axis speed into wells, 60
z-axis velocity into wells, 61
z-axis velocity out of wells, 60, 61

R
reinventorying storage device, 113
row-wise teachpoint to well property, 29
row-wise well to well property, 29

S
sealed stacking thickness property, 24
sealed thickness property, 24
sensor intensity property, 45
slot, defined, 66
software

described, 2
errors, 5
logging in, 3
reporting errors, 5
version number, vi, 5

SQL database, 66, 123, 133
stacker gripper offset property, 45
stacker, defining properties for labware, 44
stacking thickness property, 24
storage device

manually loading labware, 88
manually unloading labware, 98
reinventorying, 113
robotically loading labware, 81
robotically unloading labware, 95

synchronizing inventory database, 68
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T
technician privilege, 120
thickness property, 23

U
Unload task, 68, 71
use vacuum clamp property, 46
user accounts

changing password, 122
disabling, 121, 122
editing, 121
passwords, 121
privileges, 120
resetting lock out, 122

V
velocity property, 60

W
well depth property, 28
well diameter property, 28
well geometry property, 28
well volume property, 28
well-bottom shape property, 29

Z
z-axis

acceleration into wells property, 60, 61
acceleration out of wells property, 60, 61
speed into wells property, 60
velocity into wells property, 61
velocity out of wells property, 60, 61
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